SAP NetWeaver Composition Environment 7.1 SR5 on Linux: IBM DB2 for i5/0S

Production Edition

Target Audience

- Technology consultants
- System administrators

Document version: 1.1 – 05/16/2008
Document History

⚠️ Caution

Before you start the implementation, make sure you have the latest version of this document. You can find the latest version at [http://www.sdn.sap.com/irj/sdn/nw-ce](http://www.sdn.sap.com/irj/sdn/nw-ce).

The following table provides an overview of the most important document changes.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>5/16/2008</td>
<td>Initial Version</td>
</tr>
</tbody>
</table>
# Table of Contents

**Chapter 1**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>1.1 How to Use This Guide</td>
<td>5</td>
</tr>
<tr>
<td>1.2 New Features</td>
<td>6</td>
</tr>
<tr>
<td>1.3 SAP Notes for the Installation</td>
<td>8</td>
</tr>
<tr>
<td>1.4 Online Information from SAP</td>
<td>9</td>
</tr>
<tr>
<td>1.5 Accessing the SAP Library</td>
<td>10</td>
</tr>
<tr>
<td>1.6 Naming Conventions</td>
<td>11</td>
</tr>
</tbody>
</table>

**Chapter 2**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning</td>
<td>13</td>
</tr>
<tr>
<td>2.1 Installation Options Covered by this Guide</td>
<td>13</td>
</tr>
<tr>
<td>2.1.1 Standard System</td>
<td>13</td>
</tr>
<tr>
<td>2.1.2 Distributed System</td>
<td>14</td>
</tr>
<tr>
<td>2.1.3 Additional Application Server Instance</td>
<td>14</td>
</tr>
<tr>
<td>2.1.4 Standalone Host Agent</td>
<td>16</td>
</tr>
<tr>
<td>2.2 SAP System Transport Host</td>
<td>17</td>
</tr>
<tr>
<td>2.3 Running Adobe Document Services on Nonsupported Platforms</td>
<td>18</td>
</tr>
<tr>
<td>2.4 Integration of LDAP Directory Services</td>
<td>18</td>
</tr>
</tbody>
</table>

**Chapter 3**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparation</td>
<td>23</td>
</tr>
<tr>
<td>3.1 Basic SAP System Parameters</td>
<td>24</td>
</tr>
<tr>
<td>3.2 Hardware and Software Requirements</td>
<td>29</td>
</tr>
<tr>
<td>3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional)</td>
<td>31</td>
</tr>
<tr>
<td>3.2.2 Requirements for Linux</td>
<td>32</td>
</tr>
<tr>
<td>3.2.3 Requirements for an Additional Application Server Instance</td>
<td>33</td>
</tr>
<tr>
<td>3.2.4 Requirements for a Standalone Host Agent</td>
<td>35</td>
</tr>
<tr>
<td>3.2.5 Checking and Modifying the Linux Kernel</td>
<td>35</td>
</tr>
<tr>
<td>3.2.6 Setting up Swap Space for Linux</td>
<td>36</td>
</tr>
<tr>
<td>3.3 Creating Operating System Users and Groups</td>
<td>36</td>
</tr>
<tr>
<td>3.3.1 Creating Linux Groups and Users (Optional)</td>
<td>39</td>
</tr>
<tr>
<td>3.4 Setting Up File Systems and Raw Devices</td>
<td>39</td>
</tr>
<tr>
<td>3.4.1 SAP Directories</td>
<td>40</td>
</tr>
<tr>
<td>3.4.2 Host Agent Directories</td>
<td>44</td>
</tr>
<tr>
<td>3.4.3 Setting Up Standard File Systems and Raw Devices for Linux</td>
<td>44</td>
</tr>
<tr>
<td>3.5 Exporting and Mounting the Global Transport Directory</td>
<td>45</td>
</tr>
<tr>
<td>3.6 Exporting Directories via NFS for System i</td>
<td>46</td>
</tr>
</tbody>
</table>
Chapter 4  

Installation  
4.1 Exporting and Mounting Global Directories  
4.2 Running SAPinst  
4.3 SAPinst Installation Options  
4.4 Installing Additional Components (Optional)  
4.5 Installing SAP Memory Analyzer (Optional)  

Chapter 5  

Post-Installation  
5.1 Logging On to the Application Server  
5.2 Ensuring User Security  
5.3 Configuring the Transport Management System  
5.4 Configuring the Remote Connection to SAP Support  
5.5 Applying the Latest Kernel and Support Packages  
5.6 Post-Installation Steps for the Host Agent  
5.7 Checking the SAP Java Documentation  
5.8 CE-Specific Post-Installation Activities  
5.9 Performing a Full Installation Backup  
5.10 Post-Installation Steps for the Diagnostics Agent  

Chapter 6  

Additional Information  
6.1 Transporting Self-Developed Software Component Archives (SCA) into the System  
6.2 Configuration Templates  
6.3 Uninstalling SAP NetWeaver Composition Environment  
6.4 Mounting a CD / DVD for Linux  
6.5 Heterogeneous SAP System Installation  
6.6 Starting and Stopping SAP System Instances  
6.6.1 Starting and Stopping the SAP System Using the SAP Management Console  
6.6.2 Starting and Stopping the SAP Instance Using Commands  
6.6.3 Starting and Stopping the Diagnostics Agent Using Scripts  
6.7 Deleting an SAP System  

Exporting and Mounting Directories via NFS for Linux (Optional)  
Preparing the Installation DVDs
1 Introduction

Note
This document only applies if you are installing on a Linux operating system against IBM DB2 for i5/OS.

This document explains how to install an SAP NetWeaver Composition Environment system as productive edition.
For more information about SAP NetWeaver Composition Environment, see http://sdn.sap.com/irj/sdn/nw-ce.

Constraints
You need to consider the following constraints before you start your installation:

- You must only use the SAP installation tools according to the instructions and for the purposes described in the SAP installation document. Improper use of the SAP installation tools can damage files and systems already installed.
- SAP system installations should only be performed by SAP Technical Consultants certified for your operating system, your database, and the SAP system that you are installing.
- For downward-compatible releases of DB/OS platforms for SAP products, SAP plans to regularly release the newest database (DB) and operating-system (OS) versions of SAP products. These releases are downward-compatible with earlier SAP system releases. Note that for already shipped SAP components, we only support the installation for database versions proposed by the installation tool. Therefore, you must install an SAP component or perform a system copy using a downward-compatible database as follows:
  - Install the component with the old proposed database version.
  - Upgrade the old database version to the downward-compatible new version.

1.1 How to Use This Guide

At the beginning of each installation phase – planning, preparation, installation, and post-installation – you can find a list of the steps that you have to perform in that phase, as well as additional information. Detailed information about the steps for each phase is available in the relevant chapter. When you plan the installation, you have to decide what exactly you want to install, because the steps within each phase vary according to the installation option you choose. The following installation options are described in this document:
One or more additional application server instance(s) for an existing standard, distributed, or high-availability system

Standalone host agent

1.2 New Features

Here you can find the new features in this release.

Note

Many installation concepts have changed, so make sure that you read the installation guide carefully.

Caution

Make sure that you read the release notes for your SAP system. You can find these at http://service.sap.com/releasenotes.

SAP System Installation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAPinst</td>
<td>SAPinst has the following new features:</td>
</tr>
<tr>
<td></td>
<td>The technical terms used for the instances of an SAP system have changed as follows:</td>
</tr>
<tr>
<td></td>
<td>‑ “Central instance” (CI) is now called “primary application server instance”.</td>
</tr>
<tr>
<td></td>
<td>‑ “Dialog instance” (DI) is now called “additional application server instance”.</td>
</tr>
<tr>
<td></td>
<td>Note</td>
</tr>
<tr>
<td></td>
<td>The technical terms “Database instance”, “Java central services instance” (SCS).</td>
</tr>
<tr>
<td></td>
<td>“Central system” – meaning an SAP system running on one single host – is now called “standard system”.</td>
</tr>
<tr>
<td></td>
<td>Host agent</td>
</tr>
<tr>
<td></td>
<td>The host agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator. It is automatically installed during the installation of all SAP NetWeaver components, except TREX.</td>
</tr>
<tr>
<td></td>
<td>The host agent is automatically installed with your SAP system.</td>
</tr>
<tr>
<td></td>
<td>You can also install a standalone host agent with SAPinst. There is a new installation option Host Agent available under ‑ Software Life-Cycle Options ‑ Additional Preparations ‣.</td>
</tr>
<tr>
<td></td>
<td>You only need to install a standalone host agent in the following cases:</td>
</tr>
<tr>
<td></td>
<td>‑ You want to centrally monitor a host that does not have an SAP component.</td>
</tr>
<tr>
<td></td>
<td>‑ You want to perform an upgrade to SAP NetWeaver.</td>
</tr>
<tr>
<td></td>
<td>The locations of all installation DVDs can be entered on one screen.</td>
</tr>
<tr>
<td>Area</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Software Deployment Manager (SDM)</td>
<td>The Software Deployment Manager (SDM) is no longer part of the primary application server instance of a Java-only system. Therefore, there is no longer any technical difference between the primary application server instance and the additional application server instance of a Java-only system. The SAP system directory of both instances is now called J&lt;instance_number&gt;. J&lt;instance_number&gt; no longer exists. For more information, see SAP Dictionaries [page 40].</td>
</tr>
<tr>
<td>Installation DVDs</td>
<td>You start the installation from the Installation Master DVD for your database.</td>
</tr>
<tr>
<td>Java Library</td>
<td>There is no longer a Java library for Java systems. Everything is now in the kernel. You no longer need APYJ2EELIB and RMVJ2EELIB.</td>
</tr>
<tr>
<td>SAP Java Virtual Machine (SAP JVM)</td>
<td>You no longer have to download and install a Java Development Kit (JDK) from another software vendor as a prerequisite for the installation with SAPinst. The SAP JVM is a Java Development Kit (JDK) provided and supported by SAP. The SAP JVM is fully compliant to the Java Standard Edition 5. It is available on the Installation Master DVD and is installed automatically by SAPinst when you start the installation.</td>
</tr>
<tr>
<td>Visual Administrator tool integrated in SAP NetWeaver Administrator</td>
<td>SAP NetWeaver Administrator is a brand new solution for monitoring and administering Java systems and their applications. It is a web-based tool for administration, configuration, and monitoring. The Visual Administrator tool is no longer available as a separate tool. It has been integrated in the SAP NetWeaver Administrator. SAP NetWeaver Administrator offers you most of the functions previously available in Visual Administrator, but redesigned for the task-oriented approach of SAP NetWeaver Administrator. For more information about SAP NetWeaver Administrator, see the SAP NetWeaver Master Guide and the following:</td>
</tr>
<tr>
<td>SAP Solution Manager Diagnostics Agent</td>
<td>A SAP Solution Manager Diagnostics Agent (Diagnostics Agent) is a standalone Java program that runs on each of the systems managed by SAP Solution Manager Diagnostics. It gathers information and reports to the SAP Solution Manager system. For more information about the Diagnostics Agent, see <a href="http://service.sap.com/diagnostics">http://service.sap.com/diagnostics</a></td>
</tr>
</tbody>
</table>

- If there is no Diagnostics Agent already installed on this physical or virtual host, it is installed automatically with an AS Java primary application server instance and additional application server instance.
- You can also install it as a standalone engine, for example if you want a non-SAP system to be managed by SAP Solution Manager Diagnostics. The installation of the Diagnostics Agent as a standalone engine is not described in this installation guide, but in the Diagnostics Agent Setup Guide, which is available at http://service.sap.com/diagnostics.
1.3 SAP Notes for the Installation

You **must** read the following SAP Notes **before** you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation. Make sure that you have the up-to-date version of each SAP Note, which you can find at [http://service.sap.com/notes](http://service.sap.com/notes).

**SAP Notes for the Installation**

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>966719</td>
<td>SAP NetWeaver Inst. Based on Kernel 7.10: IBM DB2 for i5/OS</td>
<td>Platform-specific information about the SAP system installation and corrections to this documentation.</td>
</tr>
<tr>
<td>966416</td>
<td>SAP NetWeaver Installation Based on Kernel 7.10: UNIX</td>
<td>UNIX-specific information about the installation for SAP systems based on kernel 7.10 and corrections to this documentation.</td>
</tr>
<tr>
<td>73606</td>
<td>Supported Languages and Code Pages</td>
<td>Information on possible languages and language combinations in SAP systems</td>
</tr>
</tbody>
</table>
### 1.4 Online Information from SAP

More information is available online as follows.

#### Documentation

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
<th>Title</th>
</tr>
</thead>
</table>
1.5 Accessing the SAP Library

For more information about SAP NetWeaver, access the SAP Library from the SAP Help Portal at http://help.sap.com.

The references to SAP NetWeaver Library documentation in this documentation always refer to the following entry point on the SAP Help Portal:
1.6 Naming Conventions

In this documentation, the following naming conventions apply:

Terminology

- **SAP system** refers to SAP NetWeaver CE 7.1.
- **Diagnostics Agent** refers to SAP Solution Manager Diagnostics Agent.
- **SAP System ID**
  The SAP system ID is abbreviated to **SID** and **SAPSID** or **sid** and **sapsid**. For `<sid>` / `<sapid>`, substitute your SAP system ID in lower case characters, for example, `pwd`. For `<SID>` / `<SAPSID>`, substitute your SAP system ID in upper case characters, for example, `PRD`.
- **IBM System i and Short Forms**
  In this document, the short form “System i” is used for “IBM System i”. In previous versions of this document, “IBM System i” was referred to as “IBM eServer iSeries” or “IBM AS/400”.
- **IBM DB2 for i5/OS and Short Forms**
  In this document, the short form “DB2 for i5/OS” is used for the database “IBM DB2 for i5/OS”, and in certain cases, the SAP ID “DB4” is used as well. In previous versions of this document, “IBM DB2 for i5/OS” was referred to as “IBM DB2 Universal Database for iSeries” or “IBM DB2 Universal Database for AS/400” or “DB2/400”.
- **IBM i5/OS and Short Forms**
  In this document, the short form “i5/OS” is used for the operating system “IBM i5/OS”. In previous versions of this document, “IBM i5/OS” was referred to as “IBM OS/400”.

Variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;sid&gt;</code> and <code>&lt;sapsid&gt;</code></td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td><code>&lt;host_name&gt;</code></td>
<td>Name of the corresponding host</td>
</tr>
<tr>
<td><code>&lt;INSTDIR&gt;</code></td>
<td>Installation directory for the SAP system</td>
</tr>
<tr>
<td><code>&lt;DVD_DIR&gt;</code></td>
<td>Directory on which a DVD is mounted</td>
</tr>
<tr>
<td><code>&lt;OS&gt;</code></td>
<td>Operating system name within a path</td>
</tr>
</tbody>
</table>

The following example shows how the variables are used:

**Example**

Log on as user `<sapsid>adm` and change to the directory `/usr/sap/<SAPSID>`.
If your SAP system ID is C11, log on as user `c11adm` and change to the directory `/usr/sap/C11`. 

---

05/16/2008  PUBLIC  11/94
This page is intentionally left blank.
2 Planning

This section provides general planning information.
You must first:

1. Plan your SAP system landscape according to the Master Guide and the Technical Infrastructure Guide available for your product.
2. Decide on your installation option [page 13].

Now continue with the section for your chosen installation option below.

Additional Application Server Instance
You do not have to perform any planning steps.
You can immediately continue with Preparation [page 23].

Host Agent as a Standalone Installation
You do not have to perform any planning steps.
You can immediately continue with Preparation [page 23].

2.1 Installation Options Covered by this Guide

This section shows the installation options covered by this installation guide.

- You can install one or more additional application server instance(s) [page 14] to an existing standard, distributed or high-availability system.
- You can install a standalone host agent [page 16].

2.1.1 Standard System

Note
A standard system for IBM DB2 for i5/OS is only installed on System i.

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance

Optionally you can install one or more additional application server instances. For more information, see Additional Application Server Instance [page 14].
2.1.2 Distributed System

**Note**

A *distributed* system for IBM DB2 for i5/OS is only installed on System i.

In a *distributed* system, every instance can run on a separate host:

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance

**Note**

You can also use the SAP transport host or the SAP global host as your primary application server instance host.

Optionally you can install one or more additional application server instances. For more information, see *Installation of an Additional Application Server Instance* [page 14].

**Figure 1**: Distributed Java System

2.1.3 Additional Application Server Instance

You can install one or more additional application server instance(s) for an existing SAP system.
An additional application server instance can run on:

- The host of any instance of the existing SAP system (exceptions see below)
- On a dedicated host

**Note**

If you want to install additional application server instances running on another operating system than the primary application server instance, for example if your primary application server instance runs on Solaris, but the additional application server instances shall run on Windows, see *Heterogeneous SAP System Installation* [page 80].

**Additional Application Server Instance for a Standard System**

For example, the following figure shows each of the three additional application server instances that are running:

- On the main host of the SAP system, that is on the host on which the primary application server instance and the database instance run
- On dedicated hosts

**Figure 2:** Additional Application Server Instance for a Standard System

For additional information, see the section *Standard System* in the System i installation guide.
2.1 Installation Options Covered by this Guide

Additional Application Server Instance for a Distributed System

For example, the following figure shows each of the three additional application server instances that are running:

- On the main host of the SAP system, that is on the host on which the primary application server instance and the database instance run
- On dedicated hosts

It is not recommended to install additional application server instance(s) on the SAP global host.

Figure 3: Additional Application Server Instance for a Distributed System

2.1.4 Standalone Host Agent

Using the host agent you can centrally monitor any host with the Alert Monitor or the SAP NetWeaver Administrator or the Adaptive Computing Controller (ACC). In addition, the host agent is used by the ACC for starting, stopping, and relocating SAP instances and databases. For more information on the ACC see [http://sdn.sap.com/irj/sdn/adaptive](http://sdn.sap.com/irj/sdn/adaptive).

The host agent is automatically installed during the installation of all SAP NetWeaver instances and components.

You only need to install a standalone host agent in the following cases:

- You want to manage a host that does not have an SAP instance or component.
You have upgraded your SAP system to SAP NetWeaver 7.1 or higher and want to the instances of the upgraded system to be managed by the ACC.

**Figure 4:** Host Agent

The host agents contain the following elements:
- The control program `saphostexec`
- The SAP NetWeaver Management agent `SAPHostControl` (`sapstartsrv` in host mode)
- The `sapacosprep` executable of the Adaptive Computing Infrastructure
- The operating system collector `saposcol`

**More Information**
For more information about the host agent, see the SAP Library [page 10]:

- Function-Oriented View
- Application Server ABAP
- Administration Tools for AS ABAP
- Monitoring in the CCMS
- Infrastructure of the NetWeaver Management Agents

**2.2 SAP System Transport Host**

The transport host contains the transport directory that is used by the SAP transport system to store transport data and change information of SAP systems, such as software programs, data dictionary data, or customization data. If you have several SAP systems they are usually organized in transport domains. In most cases, all SAP systems in a transport domain have a common transport directory. For more information, see the SAP Library [page 10]:

05/16/2008  PUBLIC  17/94
2.3 Running Adobe Document Services on Nonsupported Platforms

Adobe document services (ADS) are currently not supported to run natively on all platforms supported by SAP systems based on SAP NetWeaver, in particular on 64-bit platforms.

Procedure
To use ADS in SAP landscapes on nonsupported platforms, install an additional standalone AS Java on a platform supported by ADS.

For more information, see SAP Note 925741.

Note
Currently, System i supports ADS only on double-stack systems. For Java systems such as CE, you must install an additional AS Java on a platform supported by ADS.

More Information
For more information about running ADS on SAP systems based on SAP NetWeaver, see http://sdn.sap.com/irj/sdn/adobe.

2.4 Integration of LDAP Directory Services

This section explains the benefits of using the SAP system with the Lightweight Directory Access Protocol (LDAP) directory and gives an overview of the configuration steps required to use an SAP system with the directory.
LDAP defines a standard protocol for accessing directory services, which is supported by various directory products such as Microsoft Active Directory, and OpenLDAP slapd. Using directory services enables important information in a corporate network to be stored centrally on a server. The advantage of storing information centrally for the entire network is that you only have to maintain data once, which avoids redundancy and inconsistency.

If an LDAP directory is available in your corporate network, you can configure the SAP system to use this feature. For example, a correctly configured SAP system can read information from the directory and also store information there.

**Note**
The SAP system can interact with the Active Directory using the LDAP protocol, which defines:

- The communication protocol between the SAP system and the directory
- How data in the directory is structured, accessed, or modified

If a directory other than the Active Directory also supports the LDAP protocol, the SAP system can take advantage of the information stored there. For example, if there is an LDAP directory on a UNIX or Windows server, you can configure the SAP system to use the information available there. In the following text, directories other than the Active Directory that implement the LDAP protocol are called **generic LDAP directories**.

**Caution**
This section does **not** provide information about the use of LDAP directories with the LDAP Connector. For more information about using and configuring the LDAP Connector for an ABAP system, see the *SAP Library* [page 10]:

- Function-Oriented View
- Security
- Identity Management
- Identity Management of the Application Server ABAP
- Configuration of Identity Management
- Directory Services
- LDAP Connector

**Prerequisites**
You can only configure the SAP system for Active Directory services or other LDAP directories if these are **already available** on the network. As of Windows 2000 or higher, the Active Directory is automatically available on all domain controllers. A generic LDAP directory is an additional component that you must install separately on a UNIX or Windows server.

**Features**
In the SAP environment, you can exploit the information stored in an Active Directory or generic LDAP directory by using:

- SAP Logon
- The SAP Microsoft Management Console (SAP MMC)
- The SAP Management Console (SAP MC)
For more information about the automatic registration of SAP components in LDAP directories and the benefits of using it in SAP Logon and SAP MMC, see the documentation *SAP System Information in Directory Services* on SAP Service Marketplace at:


For more information about the SAP MC and about how to configure it to access LDAP Directories, see the documentation *SAP Management Console* in the *SAP Library* [page 10]:


**SAP Logon**

Instead of using a fixed list of systems and message servers, you can configure SAP Logon in the `sapmsg.ini` configuration file to find SAP systems and their message servers from the directory. If you configure SAP logon to use the LDAP directory, it queries the directory each time *Server* or *Group* selection is chosen to fetch up-to-date information on available SAP systems.

To use LDAP operation mode, make sure that the `sapmsg.ini` file contains the following:

```
[Address]
Mode=LDAPdirectory
LDAPserver=
LDAPnode=
LDAPoptions=
```

Distinguish the following cases:

- If you use an Active Directory, you must set `LDAPoptions=“DirType=NT5ADS”`. For more information, see the SAP system profile parameter `ldap/options`.
- You must specify the directory servers (for example, `LDAPserver=pcintel6 p24709`) if either of the following is true:
  - The client is not located in the same domain forest as the Active Directory
  - The operating system does not have a directory service client (Windows NT and Windows 9X without installed `dcclient`).

For more information, see the SAP system profile parameter `ldap/servers`.
- For other directory services, you can use `LDAPnode` to specify the distinguished name of the SAP root node. For more information, see the SAP system profile parameter `ldap/saproot`.

**SAP MMC**

The SAP MMC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central location. It is automatically set up when you install an SAP system on Windows. If the SAP system has been prepared correctly, the SAP MMC presents and analyzes system information that it gathers from various sources, including the Active Directory.

Integrating the Active Directory as a source of information has advantages for the SAP MMC. It can read system information straight from the directory that automatically registers changes to the
system landscape. As a result, up-to-date information about all SAP application servers, their status, and parameter settings is always available in the SAP MMC.

If you need to administer distributed systems, we especially recommend that you use the SAP MMC together with Active Directory services. You can keep track of significant events in all of the systems from a single SAP MMC interface. You do not need to manually register changes in the system configuration. Instead, such changes are automatically updated in the directory and subsequently reflected in the SAP MMC.

If your SAP system is part of a heterogeneous SAP system landscape that comprises systems or instances both on Unix and Windows operating systems, you can also use the SAP MMC for operating and monitoring the instances running on Unix.

**SAP MC**

The SAP MC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central location. The SAP MC is automatically set up when you install an SAP system on any platform. If the SAP system has been prepared correctly, the SAP MC presents and analyzes system information that it gathers from various sources, including a generic LDAP Directory.

Integrating a generic LDAP Directory as a source of information has advantages for the SAP MC. It can read system information straight from the directory that automatically registers changes to the system landscape. As a result, up-to-date information about all SAP application servers, their status, and parameter settings is always available in the SAP MC.

**Configuration Tasks for LDAP Directories**

This section describes the configuration tasks you have to perform for the Active Directory or other (generic) LDAP directories.

**Configuration Tasks for Active Directory**

To enable an SAP system to use the features offered by the Active Directory, you must configure the Active Directory so that it can store SAP system data.

To prepare the directory, you use SAPInst to automatically:

- Extend the Active Directory schema to include the SAP-specific data types
- Create the domain accounts required to enable the SAP system to access and modify the Active Directory. These are the group **SAP_LDAP** and the user **sapldap**.
- Create the root container where information related to SAP is stored
- Control access to the container for SAP data by giving members of the **SAP_LDAP** group permission to read and write to the directory

You do this by running SAPInst on the Windows server on which you want to use Active Directory Services and choosing ▶ <SAP System> ▶ Software Life-Cycle Options ▶ LDAP Registration ▶ Active Directory Configuration ▶. For more information about running SAPInst on Windows, see documentation Installation Guide — <your product> on Windows : <Database>.
Note

You have to perform the directory server configuration only once. Then all SAP systems that need to register in this directory server can use this setup.

Configuration Tasks for Generic LDAP Directories

To configure other LDAP directories, refer to the documentation of your directory vendor.

Enabling the SAP System LDAP Registration

Once you have correctly configured your directory server, you can enable the LDAP registration of the SAP system by setting some profile parameters in the default profile. To do this, run SAPinst [page 53] once for your system and choose:

\[
\text{<SAP System> \rightarrow Software Life-Cycle Options \rightarrow LDAP Registration \rightarrow LDAP Support} \]

If you use a directory server other than Microsoft Active Directory and/or non-Windows application servers, you have to store the directory user and password information by using `ldappasswd pf=<any_instance_profile>`. The information is encrypted for storage in `DIR_GLOBAL` and is therefore valid for all application servers. After restarting all application servers and start services, the system is registered in your directory server. The registration protocols of the components are `dev_ldap*`. The registration is updated every time a component starts.
3 Preparation

This section includes the preparation steps that you have to perform for the:

- Additional application server instance
- Standalone host agent

**Preparation Steps for an Additional Application Server Instance**

You have to perform the following preparations on the host where you install the additional application server instance(s):

1. You identify basic SAP system parameters [page 24].
2. You check the hardware and software requirements [external document] for every installation host on which you want to install one or more additional application server instances.
3. You make sure that the required operating system users and groups [page 36] are created.
4. You set up file systems and raw devices [page 39] and make sure that the required disk space is available for the directories to be created during the installation.
5. If you want to share the transport directory trans from another system, export [page 45] this directory to your installation hosts.
6. You export directories via NFS for System i [page 46].
7. If you want to use a virtual host name, you have to set the environment variable SAPINST_USE_HOSTNAME [page ]. Alternatively you can specify the virtual host name in the command to start SAPInst.
8. You make sure that the required installation media [page 48] are available on every host on which you want to install one or more additional application server instances.
9. You can continue with Installation [page 51].

**Preparation Steps for a Standalone Host Agent**

You have to perform the following preparations on the host where you install a standalone host agent:

1. You identify basic SAP system parameters [page 24].
   You can find the parameters in the table Host Agent.
2. You make sure that the required operating system users and groups [page 36] are created.
   You can find the operating system user for the Host Agent in the tables User and Groups of the Standalone Host Agent and Groups and Members of the Standalone Host Agent User.
3. You set up file systems and raw devices [page 39] and make sure that the required disk space is available for the directories to be created during the installation.
   You can find the directories for the Host Agent in section Host Agent Directories.
4. You make sure that the required installation media [page 48] are available on the installation host. You can find the installation media that are required for the installation of a standalone host agent in the row Host Agent (Standalone) of the media table.
5. You can continue with Installation [page 51].

### 3.1 Basic SAP System Parameters

SAPinst asks whether you want to run the installation in Typical or Custom mode. If you choose Typical, SAPinst provides automatic default settings and you only have to respond to a minimum number of prompts. However, you can still change any of the default settings on the parameter summary screen. The tables below list the basic system parameters that you always need to specify before installing your SAP system, both in typical and in custom mode.

For all other SAP system parameters, use the [F1] help in the SAPinst dialogs.

**SAP System ID and Database ID**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| SAP System ID <SAPSID> | The SAP system ID <SAPSID> identifies the entire SAP system. SAPinst prompts you for the <SAPSID> when you execute the first installation option to install a new SAP system. If there are further installation options to be executed, SAPinst prompts you for the profile directory. For more information, see the description of the parameter SAP System Profile Directory. Example
This prompt appears when you install the central services instance, which is the first instance to be installed in a distributed system. Caution
Choose your SAP system ID carefully. Renaming is difficult and requires you to reinstall the SAP system. Make sure that your SAP system ID:  
- Is unique throughout your organization  
- Consists of exactly three alphanumeric characters  
- Contains only uppercase letters  
- Has a letter for the first character  
- Does not include any of the following, which are reserved IDs:
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADD ALL AND ANY ASC AUX COM CON DBA END EPS FOR GID IBM INT KEY LOG LPT MON NIX NOT NUL OFF OMS PRN RAW ROW SAP SET SGA SHG SID SQL SYS TMP UID USR VAR</td>
<td></td>
</tr>
</tbody>
</table>

### System ID `<SMDSID>` of SAP Solution Manager Diagnostics Agent

SAPInst sets `<SMDSID>` to `DAA` by default. If `DAA` is already used by another SAP system that is not a Diagnostics Agent instance, `<SMDSID>` is set to `DA<x>`, where `<x>` can be any letter from A to Z, and `DA` stands for “DiagnosticsAgent”). If required, you can change `<SMDSID>` to a value of your choice on the Parameter Summary screen. If you do so, the same naming conventions as for `<SAPSID>` apply. For more information, see entry “SAP System ID `<SAPSID>`” in this table above.

### SAP System Profile Directory

**Parameters**

```
/<sapmnt>/<SAPSID>/profile or /usr/sap/<SAPSID>/SYS/profile
```

**Description**

The installation retrieves the parameters entered earlier from the SAP system profile directory. SAPInst prompts you to enter the location of the `profile` directory when the installation option that you execute is not the first one belonging to your SAP system installation. See also the description of the parameters `SAP System ID` and `Database ID`. 
`/usr/sap/<SAPSID>/SYS/profile` is the soft link referring to `/<sapmnt>/<SAPSID>/profile`. 

**Note**

If you install an additional application server instance in an existing SAP system, SAPInst also prompts you for the profile directory of the existing SAP system.

### SAP System Instances, Hosts, and Ports

**Parameters**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Instance Number of the SAP system | **Instance Number:** Technical identifier that is required for every instance of an SAP system, consisting of a two-digit number from 00 to 97. The instance number must be unique on a host. That is, if more than one SAP instance is running on the same host, these instances must be assigned different numbers. The instance number is used to specify the names of the SAP system instance directories which are created automatically by SAPInst during the installation: 
  ■ The directory both of the primary application server instance and of an additional application server instance is called `J<Instance_Number>`. 
  ■ The directory of the central services instance is called `SCS<Instance_Number>`.

For more information, see `SAP Directories` [page 40]. |
### Parameters | Description
--- | ---
Instance Number for the Diagnostics Agent | Technical identifier for internal processes for the Diagnostics Agent, consisting of a two-digit number from 00 to 98. The instance number is set automatically to the next free and valid instance number that has not yet been assigned to the SAP system. The instance number is used to specify the name of the Diagnostics Agent instance directory which are created automatically by SAPinst during the installation: The directory of the Diagnostics Agent instance is called J<Instance_Number>. For more information, see SAP Directories [page 40]. The same restrictions apply as in “Instance Number of the SAP system” (see above).

Virtual Host Name | You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to order to conceal their physical network identities from each other. This may be useful when moving SAP servers or complete server landscapes to other new hardware within a short time frame without having to carry out a reinstallation or complicated reconfiguration. If you want to use virtual host names for the installation, you have to specify the virtual host name [page ] before you start SAPinst.  
- For more information about the use of virtual TCP/IP host names, see SAP Note 962955.
- The host name must not exceed 12 characters. For more information about the allowed host name length and characters, see SAP Note 611361.

Message Server Port | **Caution**
The message server port number must be unique for the SAP system on all hosts. If there are several message port numbers on one host, all must be unique.

Port Number of the SAP Message Server:  
If you do not specify a value, the default port number is used. The SCS instance profile contains the configuration for the Java message server. The Java message server port uses the parameter rdisp/mssrv_internal with default value 39<nn>, where <nn> is the instance number of the SCS message server instance. For more information about the parameters used for message server ports, see SAP Note 821875.

### Master Password

| Parameters | Description |
--- | --- |
Master Password | This password is used for all new user accounts SAPinst creates and for the secure store key phrase. The length has to be 8 to 14 characters. Depending on your installation scenario there might be more restrictions.  
- **Caution**
If you do not create the operating system users manually, SAPinst creates them with the common master password. For more information, see the description of the parameter Operating System Users. In this case, make sure that...
### Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>the master password meets the requirements of your operating system and of your database.</td>
<td></td>
</tr>
</tbody>
</table>

#### Operating System Users of the SAP System

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User <code>&lt;sapsid&gt;adm</code></td>
<td>User <code>&lt;sapsid&gt;adm</code> is the system administrator user. If you did not create user <code>&lt;sapsid&gt;adm</code> manually before the installation, SAPinst creates it automatically during the installation. SAPinst sets the Master Password by default, but you can overwrite it either by choosing parameter mode <code>Custom</code> or by changing it on the parameter summary screen. Make sure that the user ID and group ID of this operating system user are unique and the same on each application server instance host. For more information, see Creating Operating System Users [page 36].</td>
</tr>
<tr>
<td>User <code>sapadm</code></td>
<td>User <code>sapadm</code> is used for central monitoring services. If you did not create user <code>sapadm</code> manually before the installation, SAPinst creates it automatically during the installation. SAPinst sets the Master Password by default, but you can overwrite it either by choosing parameter mode <code>Custom</code> or by changing it on the parameter summary screen. Make sure that the user ID and group ID of <code>sapadm</code> are unique and the same on each application server instance host. For more information, see Creating Operating System Users [page 36].</td>
</tr>
<tr>
<td>User <code>&lt;smdsid&gt;adm</code></td>
<td>User <code>&lt;smdsid&gt;adm</code> is dedicated to the Diagnostics Agent installation with sufficient authorization to manage the agent. If you did not create user <code>&lt;smdsid&gt;adm</code> manually before the installation, SAPinst creates it automatically during the installation. It is created on the central instance host and on every dialog instance host. SAPinst sets the Master Password by default, but you can overwrite it either by choosing parameter mode <code>Custom</code> or by changing it on the parameter summary screen. Make sure that the user ID and group ID of <code>&lt;smdsid&gt;adm</code> are unique and the same on each application server instance host. For more information, see Creating Operating System Users [page 36].</td>
</tr>
<tr>
<td>Operating System Users and Groups</td>
<td>User ID (UID) and Group ID (GID) for the OS user: Make sure that the ID is unique and the same on each instance host. For more information about changing UIDs or GIDs on the System i host, see SAP Note [818091].</td>
</tr>
</tbody>
</table>
User Management Engine (UME)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Using the Java Database:</strong></td>
<td></td>
</tr>
<tr>
<td>Java Administrator User</td>
<td>SAPInst sets the user name <strong>Administrator</strong> and the master password by default. If required, you can choose another user name and password according to your requirements.</td>
</tr>
<tr>
<td>Java Guest User</td>
<td>SAPInst sets the user name <strong>Guest</strong> and the master password by default. The <strong>Guest</strong> user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group <strong>Authenticated Users</strong> and have read access only.</td>
</tr>
</tbody>
</table>

**Using an External ABAP System – Parameters for the ABAP Connection:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Server Instance Number</td>
<td>This is the instance number on the application server of the central ABAP system to which you want to connect the Application Server Java. To find out the number on the host of the primary application server instance, look under the SAP directory <em>usr/sap/&lt;SAPSID&gt;/DVEBMGS&lt;nn&gt;</em>. The value <em>&lt;nn&gt;</em> is the number assigned to the SAP system.</td>
</tr>
<tr>
<td>Application Server Host</td>
<td>This is the host name of the relevant application server instance. To find out the host name, enter <strong>hostname</strong> at the command prompt of the host running the primary application server instance.</td>
</tr>
<tr>
<td>Communication User</td>
<td>This is the name and password of the existing ABAP communication user. You must have created this user manually on the external ABAP system.</td>
</tr>
</tbody>
</table>

**Using an External ABAP System – Parameters for the Application Server Java Connection:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator User</td>
<td>This is the name and password of the administrator user that you created on the external ABAP system.</td>
</tr>
<tr>
<td>Administrator Role</td>
<td>The role <strong>SAP_J2EE_ADMIN</strong> must exist on the external ABAP system.</td>
</tr>
<tr>
<td>Guest User</td>
<td>This is the name and password of the guest user that you created on the external ABAP system. The guest user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group <strong>Authenticated Users</strong> and have read access only.</td>
</tr>
<tr>
<td>Guest Role</td>
<td>The role <strong>SAP_J2EE_GUEST</strong> must exist on the external ABAP system.</td>
</tr>
</tbody>
</table>

**Key Phrase for Secure Store Settings**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Phrase for Secure Store Settings</td>
<td>This is a random word or phrase that is used to encrypt the secure store. The Java EE engine uses this phrase to generate the key that is used to encrypt the data. The uniqueness of the phrase you use contributes to the uniqueness of the resulting key.</td>
</tr>
</tbody>
</table>
Parameters | Description
--- | ---
Recommendation | Use a long key phrase that cannot be guessed easily. Use both uppercase and lowercase letters in the phrase and include special characters.

Internet Communication Manager (ICM) User Management

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of <strong>webadm</strong></td>
<td>The administration user <strong>webadm</strong> is created to use the web administration interface for Internet Communication Manager (ICM) and Web Dispatcher. SAPinst sets the master password by default. If required, you can choose another password. The length of the password must be between 5 and 128 characters.</td>
</tr>
</tbody>
</table>

Host Agent

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of <strong>sapadm</strong></td>
<td>The administration user <strong>sapadm</strong> is created to use central monitoring services. If this user does not already exist, SAPinst automatically creates it. SAPinst prompts you to enter either the password of the existing user or a new password for the user to be created.</td>
</tr>
</tbody>
</table>

Parameters Relevant for the Directory Structure of the System

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP system mount directory</td>
<td>The SAP system mount directory <code>&lt;sapmnt&gt;</code> is the base directory for the SAP system. For <code>&lt;sapmnt&gt;</code> you can use a directory of your choice. If you do not specify a directory, SAPinst creates a directory named <code>sapmnt</code> by default. Do not add <code>&lt;SAPSID&gt;</code> as subdirectory because the installer adds this directory automatically.</td>
</tr>
</tbody>
</table>

**Example**

If you enter `/sapmount` for `<sapmnt>` and `KBI` for `<SAPSID>` during the input phase of the installation, the installer creates the directory `/sapmount/KBI`. For more information, see Setting Up File Systems and Raw Devices [page 39].

### 3.2 Hardware and Software Requirements

You check that your hosts meet the hardware and software requirements for your operating system and the SAP instances.
If your hosts do not fully meet the requirements, you might experience problems when working with the SAP system.

Prerequisites

- Contact your OS vendor for the latest OS patches.
- Make sure that the host name meets the requirements listed in SAP Note 61136.
- Check your keyboard definitions.

Process Flow

1. Check the Product Availability Matrix at http://service.sap.com/pam for supported operating system releases.
2. Check the hardware and software requirements using:
   - The Prerequisite Checker:
     - Standalone (optional) before the installation process
       For more information, see Running the Prerequisite Checker Standalone [page 31].
     - Integrated in the installation tool (mandatory) as part of the installation process
       For more information, see Running SAPinst [page 53].

   - The software and hardware requirements checklists for:
     - Linux [page 32]
     - If you want to install additional application server instances, check the requirements for an additional application server instance [page 33].
     - If you want to install the host agent on a host that does not have an SAP component, check the requirements for the host agent as a separate installation [page 35].

3. If you are installing a production system, the values provided by the Prerequisite Checker and the hardware and software requirements checklists are not sufficient. In addition, do the following:
     For more information about the SAP Quick Sizer and available sizing guides, see the Master Guide – SAP NetWeaver 7.0 at http://service.sap.com/installnw70 Planning #.
   - You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing depending on:
     - The set of applications to be deployed
     - How intensively the applications are to be used
The number of users

### 3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional)

Before installing your SAP system, you can run the Prerequisite Checker in standalone mode to check the hardware and software requirements for your operating system (OS) and the SAP instances.

**Recommendation**

We recommend that you use **both** the Prerequisite Checker and the requirements tables for reference.

**Note**

When installing your SAP system, SAPinst automatically starts the Prerequisite Checker and checks the hardware and software requirements in the background.

**Prerequisites**

- You have prepared the Installation Master DVD on the required installation host [page 48].
- You make sure that the required prerequisites are met before starting SAPinst [page 53].

**Procedure**

1. You start SAPinst [page 53].
2. On the Welcome screen, choose **<SAP System>** › **Software Life-Cycle Options** › **Additional Preparation Tasks** › **Prerequisites Check**.
3. Follow the instructions in the SAPinst dialogs and enter the required parameters.

**Note**

For more information about each parameter, position the cursor on the parameter field and choose **F1** in SAPinst.

When you have finished, the Parameter Summary screen appears summarizing all parameters you have entered. If you want to make a change, select the relevant parameters and choose **Revise**.

4. To start the Prerequisite Checker, choose **Start**.

**Result**

The Prerequisite Check Results screen displays the results found. If required, you can also check the results in file **prerequisite_checker_results.html**, which you can find in the installation directory.
3.2.2 Requirements for Linux

The host machine must meet the following requirements:

- The information here is **not** intended to replace the documentation of the Linux operating system (OS).
- For more information about the installation on Linux, see SAP Note 171356.

### Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
</table>
| DVD drive                 | - DVD drive  
|                           |   - ISO 9660 compatible  
|                           |   - You can configure multiple DVD drives. For more information, see *Mounting a CD / DVD for Linux* [page 79].                                        |
| CPU                       | The recommended minimum hardware is either two physical single core processors or one physical dual core processor.                                      |

### Software Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
</table>
| Operating system version  | Check the operating system version with this command:  
|                           | `cat /etc/*-release`                                                                                                                                 |
| Linux kernel version      | Check the Linux kernel version with this command:  
|                           | `uname -r`                                                                                                                                           |
| Linux kernel parameter settings | Check the Linux kernel parameter settings with this command:  
|                           | `/sbin/sysctl -a`                                                                                                                                   |
| Activated hardware drivers| Check the activated hardware drivers with this command:  
|                           | `lsmod`                                                                                                                                              |
| Shared memory file system | Check the size of the shared memory file system with this command:  
|                           | `df -k /dev/shm`                                                                                                                                 |
| Network File System (NFS) | Check whether NFS is running as follows:  
|                           | - On SUSE LINUX  
|                           |   `rcnfs status`  
|                           |   `rcnfsserver status`  
|                           |   `rcportmap status`                                                                                                                                |
| Routing information       | To check routing information, enter the following command:  
|                           | `netstat -r`                                                                                                                                          |
| System language           | For the installation, you must choose English as the operating system language on all Linux hosts that run SAP software.                          |
### 3.2 Hardware and Software Requirements

#### National Language Support (NLS)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
</table>
| To display available `locales`, enter the following command: `locale -a`  
Check the output for locales such as the following: `de_DE`, `en_US`  
`locales` are available as an attachment of SAP Note 171356. |

**C compiler**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
</table>
| The C compiler gcc must be installed. To check, enter this command: `rpm -qa | grep gcc`  
Make sure that the output of this command contains a gcc RPM package. |

### Other Requirements

#### Printer

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
</table>
| Check the status of spooling queues and printers with the following command: `lpc status`  
Check whether you can print a file with this command: `lpr -P<printer_name> <test_file>` |

#### Network

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test the network connection to the database server with the following command: <code>ping -c 10 &lt;db_server_name&gt;</code></td>
<td></td>
</tr>
</tbody>
</table>

### 3.2.3 Requirements for an Additional Application Server Instance

The additional application server host must meet the following requirements:

#### Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
</table>
| Hard disk space | - Hard disk drives with sufficient space for the additional application server instance.  
For more information, see SAP Dictionaries [page 40].  
- 4.3 GB of temporary disk space for every required installation DVD that you have to copy to a local hard disk. For more information, see Preparing the Installation DVDs [page 48].  
- 1.2 GB of temporary disk space for the installation. |

Minimum RAM  
1 GB
### Software Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP kernel</td>
<td>Make sure that the SAP kernel of the primary application server instance has at least the patch level of the SAP kernel on the SAP Kernel DVD that is used for the installation of the additional application server instance. We recommend that you apply the most current SAP kernel from the SAP Service Marketplace at <a href="http://service.sap.com/swdc">http://service.sap.com/swdc</a>.</td>
</tr>
<tr>
<td>Network File System (NFS)</td>
<td>Network File System (NFS) must be installed.</td>
</tr>
</tbody>
</table>
| Database driver | **iSeries Access for Linux and 64bit EDRS driver:** To download the latest database driver, proceed as follows:  
2. On the iSeries Access for Linux site, choose **Downloads.** Choose for download **iSeries Access for Linux V5R4.**  
3. The IBM Software Download page appears. For iSeries Access for Linux V5R4, choose version 1.4.  
4. Download iSeries Access 5.4.0 -1.4.ppc64.rpm.  
5. Install the items downloaded above. |

**Note**
The iSeries Access for Linux product and EDRS driver are delivered as RPM (Redhat Package Manager) archives. Use the setup tool of your Linux distribution to install them (SUSE: Yast), or call the `rpm` program directly from a Linux shell.

**Example**
`rpm --install iSeriesAccess-64bit-5.4.0-1.4.ppc64.rpm`

**Note**
If you face any problem installing the driver because of dependencies, use the additional parameter `--nodesp` to workaround the error.

6. Check the installation:  
- iSeries Access for Linux resides in `/opt/ibm/iSeriesAccess` on the Linux host  
- The 64-bit EDRS driver and supporting files reside in `/opt/ibm/iSeriesAccess/lib64: libcwbcore.so, libcwbrc.so, libcwbxda.so`
3.2.4 Requirements for a Standalone Host Agent

If you want to install a standalone host agent, the installation host has to meet the following requirements:

**Hardware Requirements**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard Disk Space</td>
<td>- Minimum disk space</td>
</tr>
<tr>
<td></td>
<td>- For information about the required disk space per file system, see Setting Up File Systems [page 39]</td>
</tr>
<tr>
<td></td>
<td>- 4.3 GB of temporary disk space for every required installation DVD that you have to copy to a local hard disk. For more information, see Preparing the Installation DVDs [page 48].</td>
</tr>
<tr>
<td></td>
<td>- 1.2 GB of temporary disk space for the installation.</td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>0.5 GB</td>
</tr>
</tbody>
</table>

**Software Requirements**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network File System (NFS)</td>
<td>Network File System (NFS) must be installed.</td>
</tr>
</tbody>
</table>

3.2.5 Checking and Modifying the Linux Kernel

If you are using a Linux kernel version certified by SAP, you do not need to modify the Linux kernel. To check the Linux kernel version, enter this command:

```
uname -a
```

For more information about the Linux kernel versions certified by SAP, see SAP Note 171356.

Check the Linux kernel parameters for your Linux distribution according to one of the following SAP Notes:
3.2.6 Setting up Swap Space for Linux

You created partitions of the type “swap” when you scheduled the hard disk(s) during the installation of your Linux distribution. The Linux kernel usually does not require much swap space, since other limits have already been reached before the swap space has reached full capacity (“late swap allocation”). However, if you notice the need for more swap space when using SAP software, you can use the distribution-specific tools to increase your swap space at any time.

Prerequisites

Procedure

1. To check the allocated swap space, enter the following command:
   ```shell
   swapon -s
   ```
   Recommended total size: Twice the main memory structure (2 x RAM), at least 20 GB.
   If possible, use an entire physical disk as a swap space partition.
2. If required, configure swap space as follows:
   - On SUSE LINUX, enter one of the following commands:
     ```
     yast
     yast2
     ```

   ![Note]
   You can configure multiple swap partitions up to a maximum of 32.

3.3 Creating Operating System Users and Groups

During the installation, SAPinst checks all required accounts (users, groups) and services on the local machine. SAPinst checks whether the required users and groups already exist. If not, it creates new users and groups as necessary.

If you do not want SAPinst to create operating systems users, groups, and services automatically, you can optionally create them before the installation. This might be the case if you use central user management such as Network Information System (NIS).
SAPInst checks if the required services are available on the host and creates them if necessary. See the log messages about the service entries and adapt the network-wide (NIS) entries accordingly. SAPInst checks the NIS users, groups, and services using NIS commands. However, SAPInst does not change NIS configurations.

**Recommendation**
For a distributed or a high-availability system, we recommend that you distribute account information (operating system users and groups) over the network, for example by using Network Information Service (NIS).

**Caution**
All users **must** have identical environment settings. If you change the environment delivered by SAP, such as variables, paths, and so on, we do **not** assume responsibility.

If you want to use global accounts that are configured on a separate host, you can do this in one of the following ways:

- You start SAPInst and choose `Software Life-Cycle Tasks` → `Additional Preparation Tasks` → `Operating System Users and Groups`. For more information, see Running SAPInst [page 53].
- You create operating system users and groups manually as described in Creating Linux Groups and Users (Optional) [page 39]

**Operating System Users and Groups**
SAPInst chooses available operating system user IDs and group IDs unless you are installing an additional application server instance. On an additional application server instance you have to enter the same IDs as on the host of the primary application server instance.

**Caution**
Do **not** delete any shell initialization scripts in the home directory of the OS users. This applies even if you do not intend to use the shells that these scripts are for.

**Caution**
The user ID (UID) and group ID (GID) of each operating system user and group must be identical for all servers belonging to the same SAP system. This does not mean that all users and groups have to be installed on all SAP servers.

**Users and Groups of the SAP System**

<table>
<thead>
<tr>
<th>User</th>
<th>Primary Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;sid&gt;adm</td>
<td>sapsys</td>
</tr>
</tbody>
</table>
 Users and Groups of the SAP System

<table>
<thead>
<tr>
<th>User</th>
<th>Primary Group</th>
<th>Additional Group</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapadm</td>
<td>sapsys</td>
<td>sapinst</td>
<td>Host Agent administrator</td>
</tr>
</tbody>
</table>

⚠️ Caution

If these operating system users already exist, make sure that they are assigned to group sapinst.

⚠️ Caution

If you install a distributed system and you use local operating system user accounts instead of central user management (for example, NIS), user `<sapsid>adm, sapadm`, and the database operating system user must have the same password on all hosts.

Groups and Members of the SAP System Users

<table>
<thead>
<tr>
<th>Group</th>
<th>Groups Members</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapsys</td>
<td><code>&lt;sid&gt;adm, sapadm</code></td>
</tr>
<tr>
<td>sapinst</td>
<td><code>&lt;sapsid&gt;adm, sapadm</code></td>
</tr>
</tbody>
</table>

The following users and groups correspond to each other on the System i host and the Linux application server and therefore need to have matching UIDs and GIDs (* means row is optional):

<table>
<thead>
<tr>
<th>System i Host</th>
<th>Linux Application Server</th>
<th>Match by UID and GID</th>
</tr>
</thead>
<tbody>
<tr>
<td>R3GROUP</td>
<td>sapsys (group)</td>
<td>GID</td>
</tr>
<tr>
<td><code>&lt;sid&gt;ADM</code></td>
<td><code>&lt;sid&gt;adm (user)</code></td>
<td>UID</td>
</tr>
<tr>
<td><code>&lt;sid&gt;OWNER</code></td>
<td><code>&lt;SID&gt;OWNER (user)</code></td>
<td>UID*</td>
</tr>
</tbody>
</table>

Groups and Members of the Standalone Host Agent User

<table>
<thead>
<tr>
<th>Groups</th>
<th>Members</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapsys</td>
<td>sapadm</td>
</tr>
<tr>
<td>sapinst</td>
<td>sapadm</td>
</tr>
</tbody>
</table>
3.4 Setting Up File Systems and Raw Devices

Caution
Make sure that either no group exists on the Linux host that has the same GID as the user profile R3GROUP on the System i host or that this GID belongs to the existing group sapsys on the Linux host. That is, the GID of user R3GROUP on the System i host must match the GID of group sapsys on the Linux host.

The same principle applies to user <SID>ADM on System i and <sid>adm on Linux. The UIDs must match or no Linux user with that UID or name must exist. If no such conflict exists, SAPInst creates the users and groups. All UIDs must have a 16-bit format.

For more information about how to change the UIDs and GIDs of users on the System i host, see SAP Note 818091.

3.3.1 Creating Linux Groups and Users (Optional)

You can manage Linux users with one of the following graphical tools:

- Red Hat Linux:
  - RHEL4 and higher: `system-config-users`
- SUSE Linux:
  - SLES9 and higher: `yast` or `yast2`

<table>
<thead>
<tr>
<th>Task</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating groups</td>
<td><code>groupadd</code></td>
</tr>
<tr>
<td>Modifying groups</td>
<td><code>groupmod</code></td>
</tr>
<tr>
<td>Deleting groups</td>
<td><code>groupdel</code></td>
</tr>
<tr>
<td>Creating users</td>
<td><code>useradd</code></td>
</tr>
<tr>
<td>Modifying users</td>
<td><code>usermod</code></td>
</tr>
<tr>
<td>Deleting users</td>
<td><code>userdel</code></td>
</tr>
</tbody>
</table>

3.4 Setting Up File Systems and Raw Devices

The following section(s) describe how to set up SAP file systems for the SAP instances on operating system level:

Note
The installation of any SAP system does not require a special file system setup or separate partitions.
3.4 Setting Up File Systems and Raw Devices

- **SAP Directories** [page 40]
- **Host Agent Directories** [page 44]
- **Setting Up Standard File Systems for Linux** [page 44]

## 3.4.1 SAP Directories

Here we describe the directories of a typical SAP system.

SAPinst creates the following types of directories:

- Physically shared directories, which reside on the global host and are shared by Network File System (NFS)
- Logically shared directories, which reside on the local host(s) with symbolic links to the global host
- Local directories, which reside on the local host(s)

### Features

The following figure shows the directory structure of the SAP system:

**Figure 5: Directory Structure for a Java System**
3.4 Setting Up File Systems and Raw Devices

**Figure 6:** Directory Structure for the Diagnostics Agent

<table>
<thead>
<tr>
<th>Physically shared directories</th>
<th>Logically shared directories</th>
<th>Local directories</th>
</tr>
</thead>
<tbody>
<tr>
<td>/ (root)</td>
<td></td>
<td>/&lt;SAPSID&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sap</td>
</tr>
<tr>
<td></td>
<td></td>
<td>profile</td>
</tr>
<tr>
<td>SYS profile</td>
<td></td>
<td>sapinst</td>
</tr>
<tr>
<td></td>
<td></td>
<td>script</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SMDAgent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>work</td>
</tr>
</tbody>
</table>

**Physically Shared Directories**

SAPinst creates the following directories:

- The directory `/<sapmnt>/<SAPSID>`, which contains SAP kernel and related files, is created on the first installation host. Normally, the first installation host is the host on which the central services instance is to run, but you can also choose another host for `/<sapmnt>/<SAPSID>`. You need to manually share this directory with Network File System (NFS) and – for a distributed system – mount it from the other installation hosts.

SAPinst creates the following shared directories during the SAP system installation:

- **global**
  - Contains globally shared data
- **profile**
  - Contains the profiles of all instances
- **exe**
  - Contains executable kernel programs

- The directory `/usr/sap/trans`, which is the global transport directory.
  
  If you want to use an existing transport directory, you have to mount it before you install the application server instance in question. Otherwise SAPinst creates `/usr/sap/trans` locally.

  For more information, see *Exporting and Mounting the Global Transport Directory* [page 45]
**Directory** | **Required Disk Space**
---|---
<sapmnt>/SAPSID> | - Primary application server instance: 1.5 GB  
- Central services instance: 1.0 GB  
/usr/sap/trans | This value heavily depends on the use of your SAP system. For production systems, we recommend to use as much free space as available (at least 2.0 GB), because the space requirement normally grows dynamically. For the installation, it is sufficient to use 200 MB for each SAP system instance. You can enlarge the file system afterwards.

**Logically Shared Directories**

SAPInst creates the directory /usr/sap/<SAPSID> on each host. The subdirectories contain symbolic links to the corresponding subdirectories of /<sapmnt>/<SAPSID> on the first installation host, as shown in the figure above.

Whenever a local instance is started, the sapcpe program checks the executables against those in the logically shared directories and, if necessary, replicates them to the local instance.

**Local Directories (SAP System)**

The directory /usr/sap/<SAPSID> contains files for the operation of a local instance as well as symbolic links to the data for one system.

This directory is physically located on each host in the SAP system and contains the following subdirectories:

- SYS

**Note**

The subdirectories of /usr/sap/<SAPSID>/SYS have symbolic links to the corresponding subdirectories of /<sapmnt>/<SAPSID>, as shown in the figure above.

- <INSTANCE> for each instance installed on the host

The instance-specific directories have the following names:

- The directory both of the primary application server instance and of an additional application server instance is called J<Instance_Number>.
- The directory of the central services instance is called SCS<Instance_Number>.

**Directory** | **Required Disk Space**
---|---
/usr/sap/<SAPSID> | Primary application server instance or additional application server instance: 2.5 GB

**Local Directories (Diagnostics Agent)**

The directory /usr/sap/<SMDSID> contains files for the operation of a local Diagnostics Agent instance.
This directory is physically located on each host in the SAP system and contains the following subdirectories:

- **exe**
  Contains the following global scripts:
  - `smdstart.sh`
    This script is used to start one or more Diagnostics Agent(s) available in the system landscape.
  - `smdstop.sh`
    This script is used to stop one or more Diagnostics Agent(s) available in the system landscape.
  - `smdadmin.sh`
    This script is used to manage one or more Diagnostics Agent(s) available in the system landscape.

- **<INSTANCE>**
  The directory of the Diagnostics Agent is called `DIA<Instance_Number>`.
  This directory contains the Instance-specific data of the Diagnostics Agent.
  Contains the following subdirectories:
  - **profile**
    Contains the `smd.properties` file
  - **sapinst**
    Contains log files of the installation
  - **script**
    Contains the following local scripts:
    - `smdstart.sh`
      This script is used to start the local Diagnostics Agent.
    - `smdstop.sh`
      This script is used to stop the local Diagnostics Agent.
    - `smdadmin.sh`
      This script is used to manage the local Diagnostics Agent.
  - **SMDAgent**
    Contains the Diagnostics Agent software and properties files.
  - **work**
    This is the work directory of the Diagnostics Agent.

- **SYS**
  - **profile**
    Contains the profiles of the Diagnostics Agent instance

<table>
<thead>
<tr>
<th>Directory</th>
<th>Required Disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/usr/sap/&lt;SMDSID&gt;/J&lt;instance_number&gt;</code></td>
<td>500 MB</td>
</tr>
<tr>
<td><code>/usr/sap/&lt;SMDSID&gt;/SYS/profile</code></td>
<td></td>
</tr>
<tr>
<td><code>/usr/sap/&lt;SMDSID&gt;/exe</code></td>
<td></td>
</tr>
</tbody>
</table>
### 3.4.2 Host Agent Directories

For the host agent, the following directories are required:

<table>
<thead>
<tr>
<th>Directories</th>
<th>Description</th>
<th>Required Disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>/usr/sap/hostctrl</td>
<td>Contains the following directories:</td>
<td>70 MB</td>
</tr>
<tr>
<td></td>
<td>- exe</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Contains the profile</td>
<td></td>
</tr>
<tr>
<td></td>
<td>host_profile</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- work</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Working directory of the host agent</td>
<td></td>
</tr>
</tbody>
</table>

### 3.4.3 Setting Up Standard File Systems and Raw Devices for Linux

This section describes how to set up standard files systems for Linux.

**Note**

We do **not** recommend you to install an SAP system using raw devices. For more information, see SAP Note [405827](#).

If you still want to use raw devices, contact Linux support for information about how to set up raw devices on Linux.

**Prerequisites**

The following table shows the variables and their corresponding values.

**Variables in Standard File Systems**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;diskname&gt;</td>
<td>Full path of disk, for example /dev/sda</td>
</tr>
</tbody>
</table>

**Procedure**

1. Create an empty file system.

   **Example**

   Example for `ext2` file system:

   ```
   mke2fs -b 4096 /dev/<device>
   ```

2. Create a mount point:

   ```
   mkdir <mountpointname>
   ```

3. Add a line to `/etc/fstab`. 
Example for the ext2 file system:

```
/dev/<device> <mountpointname> ext2 defaults 1 2
```

4. Mount the file system:
```
mount <mountpointname>
```

### 3.5 Exporting and Mounting the Global Transport Directory

In your SAP system landscape, a global transport directory for all SAP systems is required. During the installation, you can select the check box SAP System will be under NWDI control on the screen NWDI Landscape. Then SAPinst copies all SCA elements belonging to the software units that you installed to the global transport directory. For more information, see the SAP Library [page 10]:

- Administrator’s Guide ➤ Software Life Cycle Management ➤ Software Logistics ➤ Using the Development and Production Infrastructure

- If the global transport directory already exists, make sure that it is exported on the global transport directory host and mount it on the SAP instance installation host.
- If the global transport directory does not exist, proceed as follows:
  - Create the transport directory (either on the host where the primary application server instance is running or on a file server).
  - Export it on the global transport directory host.
  - If you did not create the transport directory on your SAP instance installation host, mount it there.

If the global transport directory resides on the System i host, proceed as follows:

**Exporting the Transport Directory**

1. Log on as user QSECOFR to the System i host.
2. Make sure that `/usr/sap/trans` belongs to the group `sapsys` (group R3GROUP on System i) and to the user `root` (user QSECOFR on System i).
3. If not already done, export the directory using Network File System (NFS).

If the global transport directory resides on the Linux file server, proceed as follows:

**Exporting the Transport Directory**

1. Log on as user `root` to the host where the global transport directory `/usr/sap/trans` resides.
2. Make sure that `/usr/sap/trans` belongs to the group `sapsys` and to the user `root`.
3. If not already done, export the directory using Network File System (NFS).
### Mounting the Transport Directory

**Note**

If the transport directory resides on your local SAP instance installation host, you do not need to mount it.

1. Create the mount point `/usr/sap/trans`.

### More Information

*Exporting Directories via NFS for System i* [page 46]

### 3.6 Exporting Directories via NFS for System i

To export directories via NFS on your System i host (the following assumes that the primary application server instance host is the NFS server), proceed as follows:

1. Log on as user QSECOFR to the NFS server.
2. On System i, enter the command `STRNFSSVR *ALL`.

**Caution**

If you get the error message `User not enrolled in system distribution directory. File system error occurred. Error number 3498`, perform a `WRKDIR` and add your user ID.

**Note**

After an IPL of the System i host, you have to restart the NFS server to reactivate the mounted directories on the Linux application server.

3. To export a directory from a local file system enter the following configuration:
   
   a) Add a line to the local file `/etc/exports`: `#/etc/exports /sapmnt/SID ANON=-1
   
   `ROOT=<Linux host>`

   **Note**

   'ANON=-1' ensures that no requests from unknown users are allowed. 'ROOT' permits users from `<Linux host>` to access the exported directory on the System i host with QSECOFR rights.

   b) To activate the changes (that is, inform the NFS daemon about the changes performed in `/etc/exports`), enter the following command:

   `CHGNFSEXPI 'A'`

4. Log on as user `root` to the Linux host where the file system should be imported.

5. To create the `/sapmnt` file system for the SID enter the following command:
3.7 Exporting and Mounting Directories via NFS for Linux (Optional)

To export directories via NFS, perform the following steps (the following assumes that the host running the primary application server instance host is the NFS server):

1. Log on as user root to the NFS server.
2. Make sure that your host is configured as NFS server as follows:
   - On Red Hat Linux, make sure that the output of the command:
     ```bash
     chkconfig --list nfs
     ```
     looks like:
     ```
     nfs 0:off 1:off 2:off 3:on 4:on 5:on 6:off
     ```
   - On SUSE Linux, enter the following command:
     ```bash
     yast or yast2
     ```
     You can set up your host as NFS server as follows:
     - On Red Hat Linux, enter the following command:
       ```bash
       system-config-users
       ```
     - On SUSE Linux, enter the following command:
       ```bash
       yast or yast2
       ```
3. To export a directory from a local file system, you can proceed as follows:
   - On Red Hat Linux, use the following tool:
     ```bash
     system-config-nfs
     ```
   - On SUSE Linux, use the following tool:
     ```bash
     yast2
     ```
   - Perform the configuration manually:
     a) Add a line to the local file `/etc/exports`:
        ```bash
        #/etc/exports
        <directory> <hostname>{<options>}
        ```
3.8 Preparing the Installation DVDs

This section describes how to prepare the installation DVDs, which are available as follows:

- You normally obtain the installation DVDs as part of the installation package.
- You can also download the installation DVDs from SAP Service Marketplace, as described at the end of this section.

---

**Note**

- There must not be a blank between `<hostname>` and `<options>`. Otherwise, the directory is exported with default option (ro) (read-only) to the host specified by `<hostname>` **and** with the option specified by `<options>` to all other hosts.
- To export directories on Linux with root permissions, use the option `no_root_squash`. For security reasons, only use this option during installation.

**Example**

To export the directory `/usr/sap/trans` in read-only mode to the NFS client `host.wdf.sap-ag.de`:

```
# /etc/exports
/usr/sap/trans host.wdf.sap-ag.de(ro)
```

To export the directory in read-write mode with root permissions:

```
# /etc/exports
/usr/sap/trans host.wdf.sap-ag.de(rw,no_root_squash)
```

To export the directory to all NFS clients of the domain using a wildcard (`*`):

```
# /etc/exports
/usr/sap/trans *.wdf.sap-ag.de(rw)
```

b) To activate the changes (that is, inform the NFS daemon about the changes performed in `/etc/exports`), enter the following command:

```
exportfs -r
```

To get a list of all currently exported directories, enter the following command:

```
exportfs -v
```

For further details, consult the man page by entering `man exports`.

4. Log on as user `root` to the host where the file system is to be imported.

5. To mount the file systems, enter the following command:

```
mount <nfs_server>:<file_system> <mount_point>
```

**Example**

```
mount <nfs_server>:/usr/sap/trans /usr/sap/trans
```
1. Identify the required DVDs for your installation [page 13] as listed below. Keep them separate from the remaining DVDs as this helps you to avoid mixing up DVDs during the installation.

Note
- The media names listed in the following table are abbreviated.
- You can find the Software Component Archives (SCAs) for the installation of SAP NetWeaver usage types on the NetWeaver Java DVD.

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required DVDs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional application server instance</td>
<td>Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>NetWeaver Java DVD</td>
</tr>
<tr>
<td></td>
<td>Kernel DVD</td>
</tr>
<tr>
<td>Host Agent (Standalone)</td>
<td>Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>Kernel DVD</td>
</tr>
</tbody>
</table>

2. Make the required installation media available on each installation host. If you need information about how to mount DVDs on Linux, see Mounting a CD / DVD for Linux [page 79].

Note
- Depending on your installation type, one or more instances can reside on the same host. You need to keep this in mind when you make the required installation media available on each installation host.
- For a standard system, you need to make all required installation media available on the single installation host.

Use one of the following methods to make DVDs available:
- **Before** the installation, copy DVDs manually to local hard disks.
- **During** the installation, use the SAPinst Media Browser dialog and copy the entire DVDs to the path you entered in the Copy To column.

Caution
- Mount the DVDs locally. We do not recommend you to use Network File System (NFS), because reading from DVDs mounted with NFS might fail.
- If you copy the DVDs to disk, make sure that the paths to the destination location of the copied DVDs do not contain any blanks.
- If you perform a local installation and there is only one DVD drive available on your installation host, you must copy at least the Installation Master DVD to the local file system.
3.8 Preparing the Installation DVDs

**Downloading Installation DVDs from SAP Service Marketplace (Optional)**

You normally obtain the installation DVDs as part of the installation package from SAP. However, you can also download installation DVDs from SAP Service Marketplace at:


**Note**

If you download installation DVDs, note that the DVDs might be split into several files. In this case, you have to reassemble the required files after the download.

**Caution**

To extract the downloaded SAR files make sure that you use the latest SAPCAR version, which you can find on SAP Service Marketplace at [http://service.sap.com/swdc](http://service.sap.com/swdc). You need at least SAPCAR 700 or SAPCAR 640 with patch level 4 or higher because older versions of SAPCAR can no longer unpack current SAR files. For more information, see SAP Note 212876.

1. Create a download directory on the host where you want to run SAPinst.
2. Identify all download objects that belong to one installation DVD according to one or both of the following:
   - Material number
     - All download objects that are part of an installation DVD have the same material number and an individual sequence number:
       <material_number>_<sequence_number>
   - Example
     - 51031387_1
     - 51031387_2
     - ...
   - Title
     - All objects that are part of an installation DVD have the same title, such as
       <solution><DVD_name><OS> or <database>RDBMS<OS> for RDBMS DVDs.
3. Download the objects to the download directory.
4. Extract the individual download objects using SAPCAR, starting with the lowest sequence number – for example 51031387_1, then 51031387_2, and so on.
   - During the download SAPCAR sets up the structure of the installation DVD.

**Note**

SAPCAR asks if you want to replace existing files, for example LABELIDX.ASC. Always accept with Yes.
4 Installation

Installation Steps for an Additional Application Server Instance

1. On the main host on which your SAP system runs, you export global directories in `<sapmnt>/<SAPSID>` to the database and primary application server instance host.
2. On every additional application server instance host, you do the following:
   a) You mount the global directories [page 52] in `<sapmnt>/<SAPSID>` that you exported from the SAP global host.
   b) You run SAPInst [page 53] to install the additional application server instance.
3. You continue with Post-Installation [page 63].

Installation Steps for an Application Server Instance for a Distributed System

1. If you want to share the transport directory `trans` from another system, you have to mount [page 45] it from this system. Otherwise we recommend that you share the `trans` directory that is created during the installation of the primary application server instance.
2. On the SAP global host, you export global directories in `<sapmnt>/<SAPSID>` to the database and primary application server instance host.
3. On every additional application server instance host, you do the following:
   a) You mount the global directories [page 52] in `<sapmnt>/<SAPSID>` that you exported from the SAP global host.
   b) You run SAPInst [page 53] to install the additional application server instance.
   c) If you want to use the shared transport directory `trans` from another system, also mount [page 45] this directory.
4. You continue with Post-Installation [page 63].

Installation Steps for an Additional Application Server Instance for a High-Availability System

1. If you want to share the transport directory `trans` from another system, you have to mount [page 45] it from this system. Otherwise we recommend that you share the `trans` directory that is created during the installation of the primary application server instance.
2. On the primary node, host A, of the switchover cluster infrastructure, you export global directories in `<sapmnt>/<SAPSID>` to every additional application server instance host.
3. On every additional application server instance host, you do the following:
Installation

4.1 Exporting and Mounting Global Directories

a) You mount the global directories [page 52] in `<sapmnt>/<SAPSID>` that you exported from the SAP global host.

b) You run SAPInst [page 53] to install the additional application server instance.

c) If you want to use the shared transport directory `trans` from another system, you also mount [page 45] this directory.

4. You continue with Post-Installation [page 63].

Installation Steps for Additional Components and Tools for SAP NetWeaver CE (Optional)

- You install additional components [page 59] for SAP NetWeaver Composition Environment, such as
  - Composition Tools
  - Adobe Document Services
  - Composite Voice
  - IDE Update Site

Installation Steps for a Standalone Host Agent

1. You run SAPInst [page 53] to install the host agent.

2. You continue with Post-Installation [page 63].

4.1 Exporting and Mounting Global Directories

If you install an additional application server instance on a host other than the SAP Global host, you must mount directories from the SAP Global host.

Prerequisites

If you want to install the executables locally instead of sharing them, do not mount the `exe` directory with Network File System (NFS). Instead, create `<sapmnt>/<SAPSID>/exe` as a local directory (not a link) with a minimum of 1.5 GB free space.

Procedure

1. Log on to the SAP Global host as user `root` and export the following directories with `root` access to the host where you want to install the new instance:

   `<sapmnt>/<SAPSID>`

   or

   `<sapmnt>/<SAPSID>/exe`

   `<sapmnt>/<SAPSID>/profile`

   `<sapmnt>/<SAPSID>/global`

   For Java:

   `<sapmnt>/<SAPSID>/j2ee`
4.2 Running SAPinst

This procedure tells you how to install an SAP system with SAPinst. SAPinst includes a SAPinst GUI and a GUI server, which both use Java.

If you need to see the installation on a remote display, we recommend you perform a remote installation with SAPinst [external document], where SAPinst GUI is running on a separate host from SAPinst and the GUI server. Alternatively you can use an X Server for Microsoft Windows or other remote desktop tools like vncviewer or nxserver/ncxclient offered by various vendors (or OpenSource) for the Remote Access of SAPinst GUI on Windows Workstations. We recommend you use the Hummingbird Exceed X Server which we use ourselves to validate installations with SAPinst.

Note the following information about SAPinst:

- SAPinst normally creates the installation directory sapinst_instdir directly below the temporary directory. SAPinst finds the temporary directory by checking the value of the TEMP, TMP, or TMPDIR environment variable. If no value is set for these variables, SAPinst uses /tmp as default installation directory.

- If you want to use an alternative installation directory, set the environment variable TEMP, TMP, or TMPDIR to the required directory before you start SAPinst.

  Recommendation

  We recommend that you keep all installation directories until the system is completely and correctly installed.

- SAPinst creates a subdirectory for each installation option called sapinst_instdir/<installation_option_directory>.

- The SAPinst Self-Extractor extracts the SAPinst executables to the temporary directory. These executables are deleted after SAPinst has stopped running. Directories called sapinst_exe.xxxxxx.xxxx sometimes remain in the temporary directory. You can safely delete them.

  The temporary directory also contains the SAPinst Self-Extractor log file dev_selfex.out, which might be useful if an error occurs.
If SAPinst cannot find a temporary directory, the installation terminates with the error FCO-00058.

During the installation, the default ports 21200, 21212, and 4239 are used for communication between SAPinst, GUI server, SAPinst GUI and HTTP server. SAPinst uses port 21200 to communicate with the GUI server. The GUI server uses port 21212 to communicate with SAPinst GUI. 4239 is the port of the HTTP server, which is part of the GUI server. You get an error message if one of these ports is already in use by another service.

In this case, you must execute sapinst using the following parameters:
- \`SAPINST_DIALOG_PORT=<free_port_number_sapinst_to_gui_server>\`
- \`GUISERVER_DIALOG_PORT=<free_port_number_gui_server_to_sapinst_gui>\`
- \`GUISERVER_HTTP_PORT=<free_port_number_http_server>\`

To get a list of all available SAPinst properties, start SAPinst as described above with the option `-p`:
- `./sapinst -p`.

If required, you can terminate SAPinst and the SAPinst Self-Extractor by pressing `Ctrl` + `C`.

### Using SAPinst GUI

The following table shows the most important functions that are available in SAPinst GUI:

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function key</td>
<td>F1</td>
<td>Displays detailed information about each input parameter</td>
</tr>
<tr>
<td>Menu option</td>
<td>File</td>
<td>Stops the SAPinst GUI, but SAPinst and the GUI server continue running</td>
</tr>
<tr>
<td>Menu option</td>
<td>SAPinst</td>
<td>Displays the Log Viewer dialog</td>
</tr>
<tr>
<td>Menu option</td>
<td>Log Browser</td>
<td>This dialog enables you to access the following log files directly:</td>
</tr>
<tr>
<td>Menu option</td>
<td>SAPinst</td>
<td>Installation log (sapinst_dev.log)</td>
</tr>
<tr>
<td>Menu option</td>
<td>Cancel</td>
<td>Log files from the SAPinst GUI server</td>
</tr>
<tr>
<td>Message button</td>
<td>Retry</td>
<td>Cancels the installation with the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Stop</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stops the installation (SAPinst GUI, SAPinst and the GUI server) without further changing the installation files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can restart and continue the installation later from this point.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Continue</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Continues the installation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Performs the installation step again (if an error has occurred)</td>
</tr>
</tbody>
</table>
### Prerequisites

- Make sure that your operating system does not delete the contents of the temporary directory `/tmp` or the contents of the directories to which the variables `TEMP`, `TMP`, or `TMPDIR` point, for example by using a `crontab` entry.
- Make sure that the temporary directory has the permissions 777.
- Make sure that you have at least 300 MB of free space in the installation directory for each installation option. In addition, you need 300 MB free space for the SAPinst executables. If you cannot provide 300 MB free space in the temporary directory, you can set one of the environment variables `TEMP`, `TMP`, or `TMPDIR` to another directory with 300 MB free space for the SAPinst executables.

You can set values for the `TEMP`, `TMP`, or `TMPDIR` environment variable as follows:

<table>
<thead>
<tr>
<th>Shell Used</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bourne shell (sh)</td>
<td><code>TEMP=&lt;directory&gt;</code></td>
</tr>
<tr>
<td></td>
<td><code>export TEMP</code></td>
</tr>
<tr>
<td>C shell (csh)</td>
<td><code>setenv TEMP &lt;directory&gt;</code></td>
</tr>
<tr>
<td>Korn shell (ksh)</td>
<td><code>export TEMP=&lt;directory&gt;</code></td>
</tr>
</tbody>
</table>

- Make sure that your `DISPLAY` environment variable is set to `<host_name>:0.0`, where `<host_name>` is the host on which you want to display the SAPinst GUI.

You can set values for the `DISPLAY` environment variables as follows:

<table>
<thead>
<tr>
<th>Shell Used</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bourne shell (sh)</td>
<td><code>DISPLAY=&lt;host_name&gt;:0.0</code></td>
</tr>
<tr>
<td></td>
<td><code>export DISPLAY</code></td>
</tr>
<tr>
<td>C shell (csh)</td>
<td><code>setenv DISPLAY &lt;host_name&gt;:0.0</code></td>
</tr>
<tr>
<td>Korn shell (ksh)</td>
<td><code>export DISPLAY=&lt;host_name&gt;:0.0</code></td>
</tr>
</tbody>
</table>

- Make sure that you have checked the following values for user root:

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message button</td>
<td>Stop</td>
<td>Stops the installation without further changing the installation files. You can continue the installation later from this point.</td>
</tr>
<tr>
<td>Message button</td>
<td>Continue</td>
<td>Continues with the option you have chosen before.</td>
</tr>
</tbody>
</table>
In **csh** execute `limit`

<table>
<thead>
<tr>
<th>Output</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>cputime</td>
<td>unlimited</td>
</tr>
<tr>
<td>filesize</td>
<td>unlimited</td>
</tr>
<tr>
<td>datasize</td>
<td>2097148 KB</td>
</tr>
<tr>
<td>stacksize</td>
<td>8192 KB</td>
</tr>
<tr>
<td>coredumpsize</td>
<td>unlimited</td>
</tr>
<tr>
<td>descriptors</td>
<td>8192</td>
</tr>
<tr>
<td>memorysize</td>
<td>unlimited</td>
</tr>
</tbody>
</table>

In **sh** or **ksh** execute `ulimit -a`

<table>
<thead>
<tr>
<th>Output</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>time(seconds)</td>
<td>unlimited</td>
</tr>
<tr>
<td>file(blocks)</td>
<td>unlimited</td>
</tr>
<tr>
<td>data(kbytes)</td>
<td>2097148</td>
</tr>
<tr>
<td>stack(kbytes)</td>
<td>8192</td>
</tr>
<tr>
<td>coredump(blocks)</td>
<td>unlimited</td>
</tr>
<tr>
<td>nofiles(descriptors)</td>
<td>8192</td>
</tr>
<tr>
<td>memory(KBytes)</td>
<td>unlimited</td>
</tr>
</tbody>
</table>

If your parameter settings differ from the settings above, change these values accordingly.

**Example**

If you have to change the value for descriptors to 8192, proceed as follows:

- In **csh** execute:
  ```
  limit descriptors 8192
  ```

- In **sh** or **ksh** execute:
  ```
  ulimit -n 8192
  ```

Make sure that you have defined the most important SAP system parameters as described in *Basic SAP System Parameters* [page 24] before you start the installation.

Check that your installation host(s) meets the requirements for the installation option(s) that you want to install. For more information, see *Running the Prerequisite Checker* [page 31].

**Procedure**

1. Log on to your host as user `root`. 
4  Installation

4.2 Running SAPinst

⚠️ Caution
Make sure that the root user has not set any environment variables for a different SAP system or database.

2. Start SAPinst from the Installation Master DVD by entering the following commands:

   cd <Installation_Master_DVD>/DATA_UNITS/IM_LINUX_PPC64_DB4
   ./sapinst

⚠️ Caution

- Make sure that the installation directory is not mounted with NFS, or there might be problems when the Java Virtual Machine is started.
- Make sure that your current working directory is not an IM_<OS>_<DB> directory belonging to another operating system.

For example, if your operating system is HP-UX PARISC and your database is Oracle, the following commands are incorrect and cause an error:

   $ cd /sapcd2/DATA_UNITS/IM_HPUX_IA64_ORA
   $ /sapcd2/DATA_UNITS/IM_HPUX_PARISC_ORA/sapinst

   The following commands are correct:
   $ cd /sapcd2/DATA_UNITS/IM_HPUX_PARISC_ORA
   $ /sapcd2/DATA_UNITS/IM_HPUX_PARISC_ORA/sapinst

3. In the Welcome screen, choose the required SAPinst installation option from the tree structure.
   For more information, see SAPinst Installation Options [page 58].

4. Follow the instructions in the SAPinst input dialogs and enter the required parameters.

💡 Note
To find more information on each parameter during the input phase of the installation, position the cursor on the required parameter and press [F1].

5. To start the installation, choose Start.
   SAPinst starts the installation and displays the progress of the installation. When the installation has successfully completed, SAPinst shows the dialog Execution of <option_name> has been completed successfully.

6. If required, delete directories with the name sapinst_exe.xxxxxx.xxxx after SAPinst has finished. Sometimes these remain in the temporary directory.

💡 Note
If there are errors with SAPinst Self-Extractor, you can find the Self-Extractor log file dev_selfex.out in the temporary directory.
4.3 SAPinst Installation Options

**Recommendation**

We recommend that you keep all installation directories until you are sure that the system is completely and correctly installed.

7. We recommend you to delete all files in the directory `<user_home>/sdtgui/`.
8. If you have copied installation DVDs to your hard disk, you can delete these files when the installation has successfully completed.

**More Information**

- [Interrupted Installation with SAPinst](#) [external document]
- [Entries in the Services File Created by SAPinst](#) [external document]
- [Troubleshooting with SAPinst](#) [external document]

### 4.3 SAPinst Installation Options

This section provides information about the following in SAPinst:

- [Software Life-Cycle Options](#)

**Note**

- Choose the required installation options from the tree structure **exactly** in the order they appear for each system variant.
- If you want to use global accounts, which are configured on separate hosts, you must run the installation option `Operating System Users and Groups before` you start the installation of the SAP system (see table Software Life-Cycle Options below).
- If required, install an additional application server instance for a standard system (all instances on one host) or distributed system by choosing `<SAP System> Software Life-Cycle Options Additional Application Server Instance Additional Application Server Instance`.
- If required, install additional CE components by choosing `<SAP System> Software Life-Cycle Options Additional CE Components Additional CE components`.
- If required, install SAP Memory Analyzer by choosing `<SAP System> Software Life-Cycle Options SAP Memory Analyzer SAP Memory Analyzer`.

**Software Life-Cycle Options**

You use the options located in this folder to perform the following tasks or to install the following components:
### Installation Option | Remarks
---|---
**Additional Preparations** | - **Host Agent**
Choose [**Additional Preparations**](#) [**Host Agent**](#) to install the host agent with the profiles **SAPSystem=99** and **SAPSystemName=SAP**.
The host agent contains all of the required elements for centrally monitoring any host.
Normally you do not need to install a standalone host agent, because it is automatically installed during the installation of all SAP NetWeaver components, except TREP.
You only need to install a standalone host agent when:
- You want to centrally monitor a host that does not have an SAP component.
- You want to perform an upgrade to SAP NetWeaver.
- Operating system users and groups
  Lets you use global accounts that are configured on a separate host

⚠️ **Caution**
Perform this SAPinst option **before** you start the installation of your SAP system.

- **Prerequisites check**
Choose [**Additional Preparations**](#) [**Prerequisites Check**](#) if you want to check your hardware and software requirements **before** you start the installation.
Otherwise, SAPinst automatically checks the hardware and software requirements during the installation with the **Prerequisite Checker**. If any changes are necessary to the SAP system or operating system settings, SAPinst automatically prompts you. For more information, see **Running the Prerequisites Checker in Standalone Mode (page 31)**.

**Additional Application Server Instances** | Choose [**Additional Application Server Instances**](#) [**Additional Application Server Instance**](#) to install one or more additional application server instance(s) in an already installed SAP system, if required.

**Additional CE Components** | Choose this option to install additional CE components, such as
- Composition Tools
- Adobe Document Services (if available for your platform)
- Composite Voice
- IDE Update Site

**SAP Memory Analyzer** | Choose this option to install SAP Memory Analyzer.
SAP Memory Analyzer helps you to analyze Java heap dumps, easily find big chunks of memory or complex memory aggregation patterns in your data structures and identify who is keeping this memory alive.

### 4.4 Installing Additional Components (Optional)

You can install the following additional components:
- **Composition Tools**
Com

Prerequisites
You need to fulfill the same hardware and software requirements as for your already installed production system plus an additional 2 GB RAM.
The Composition Tools and Composite Voice component make use of the Visual Composer. Visual Composer is a Web browser based tool to model user interfaces. To run Visual Composer, the following programs must be installed on the client computer from which you access Visual Composer:

- Microsoft Internet Explorer 6.0 SP1 or higher
- Adobe SVG Viewer 3.0
- Microsoft XML Parser 4.0 or higher

Note
- Before installing additional components, you need to stop all application servers manually.
- Before installing additional components and in the case that you made changes to the default template settings, see SAP Note 953763.

Procedure

Note
When installing from a network share make sure that everyone has read access to this share. The installation routine creates users such as <sid>adm (for example, ce1adm). During the installation SAPinst does a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPinst [page 53].
3. In the Welcome screen, choose SAP NetWeaver CE Productive System Software Life-Cycle Options Additional CE Components Install Additional Components.
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.
If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode.

After the installation, you can access the offline documentation by choosing Start > All Programs > SAP NetWeaver Composition Environment > <SAPSID>.

5. Follow the screens and enter the required parameters.

For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press [F1].

After you have entered all requested input parameters, SAPinst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPinst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPinst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPinst shows the dialog Execution of <Option_Name> has been completed successfully.

After installing additional components, you need to perform CE-specific post-installation activities [page 70] to get the system up & running.

4.5 Installing SAP Memory Analyzer (Optional)

SAP Memory Analyzer helps you to analyze Java heap dumps, easily find big chunks of memory or complex memory aggregation patterns in your data structures and identify who is keeping this memory alive. New and innovative analysis techniques support the user with a fast and powerful feature set.

The tool (Eclipse RCP application) was developed to analyze real productive heap dumps, which tend to get enormous in size with hundreds of millions of objects. Performance, low resource consumption and especially the newly developed innovative analysis techniques make it a helpful tool, even to small application heap dumps.

You can install SAP Memory Analyzer as an additional tool.
Procedure

Note
When installing from a network share make sure that everyone has read access to this share. The installation routine creates users such as <sid>adm (for example, ce1adm). During the installation SAPInst performs a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPInst [page 53].
3. In the Welcome screen, choose ‣ SAP NetWeaver CE Productive System ‣ Software Life-Cycle Options ‣ SAP Memory Analyzer ‣ Install SAP Memory Analyzer ‣.
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.

Note
If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode.
After the installation, you can access the offline documentation by choosing ‣ Start ‣ All Programs ‣ SAP NetWeaver Composition Environment ‣ <SAPSID> ‣.

5. Follow the screens and enter the required parameters.

Note
For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press [F1].

After you have entered all requested input parameters, SAPInst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPInst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPInst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPInst shows the dialog Execution of <Option_Name> has been completed successfully.
5 Post-Installation

This section includes the post-installation steps that you have to perform for the:

- Additional application server instance
- Standalone host agent

**Additional Application Server Instance**

1. If required, you perform a full installation backup [page 73] immediately after the installation has finished.
2. You check whether you can log on to the additional application server instance [page 63].
3. You perform a full installation backup [page 73].
4. If you want or need to implement the E2E Root Cause Analysis scenario, you have to perform post-installation steps for the Diagnostics Agent [page 74] on your central instance and/or dialog instance(s).

**Standalone Host Agent**

You perform the post-installation steps for the Host Agent [page 68].

5.1 Logging On to the Application Server

You need to check that you can log on to the application server using the following standard users:

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>User Name Storage: External ABAP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Administrator</td>
<td>You create this user manually during the installation process.</td>
</tr>
</tbody>
</table>

Recommendation

We recommend that you call the user J2EE_ADM_<SAPSID_Java_System>

The maximum length is 12 characters.

**Prerequisites**

- The SAP system is up and running.
Logging On to the Java Application Server

You access AS Java with a URL using a Web browser from your client machines. To log on to the Java application server, proceed as follows:

1. Start a Web browser and enter the following URL:
   \[ http://<hostname_of_Java_EE_Engine_Server>:5<Instance_Number>00 \]

   **Note**
   
   You must always enter a two-digit number for `<Instance_Number>`. For example, do not enter 1 but instead enter 01.

   **Example**
   
   If you installed the SAP NetWeaver Application Server Java on host saphost06 and the instance number of your SAP NetWeaver Application Server Java is 04, enter the following URL:
   \[ http://saphost06:50400 \]

   The start page of the SAP NetWeaver Application Server Java appears in the Web browser.

2. Log on by pressing the icon of any of the provided applications, for example the *SAP NetWeaver Administrator*.

5.2 Ensuring User Security

You need to ensure the security of the users that SAPinst creates during the installation. For security reasons, you also need to copy the installation directory to a separate, secure location — such as a DVD — and then delete the installation directory.

**Recommendation**

In all cases, the user ID and password are only encoded when transported across the network. Therefore, we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL) protocol for HTTP connections, or Secure Network Communications (SNC) for the SAP protocols dialog and RFC.

For more information, see the *SAP Library* [page 10]:

* Function-Oriented View  ➤ Security  ➤ Network and Transport Layer Security

**Caution**

Make sure that you perform this procedure **before** the newly installed SAP system goes into production.
Prerequisites
If you change user passwords, be aware that SAP system users might exist in multiple SAP system clients (for example, if a user was copied as part of the client copy). Therefore, you need to change the passwords in all the relevant SAP system clients.

Procedure
For the users listed below, take the precautions described in the relevant SAP security guide, which you can find on SAP Service Marketplace at http://service.sap.com/securityguide:

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sapadm</td>
<td>SAP system administrator You do not need to change the password of this user after the installation. This user is for administration purposes only.</td>
</tr>
</tbody>
</table>

Note
You can set up Java standalone users with the SAP User Management Engine (UME) in one of the following ways:

- With the users stored in an external ABAP system — see the first table below
- With the users stored in the database — see the second table below

The next two tables show these ways of managing the users.

SAP System Users Stored in an External ABAP System

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: External ABAP System</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>This user’s password is stored in secure storage. Therefore, whenever you change the administrator's password, you must also change the password in secure storage with the Config Tool. For more information, see Checking the SAP Java Documentation [page 69].</td>
</tr>
</tbody>
</table>

Recommendation
We recommend that you call the user J2EE_ADM_<SAPSID_Java_System> The maximum length is 12 characters.
5.3 Configuring the Transport Management System

You have to perform some steps to be able to use the Transport Management System.

**Procedure**

1. Perform post-installation steps for the transport organizer:
   a) Call transaction SE06.
   b) Select Standard Installation.
   c) Choose Perform Post-Installation Actions.
2. Call transaction STMS in your SAP Solution Manager system to configure the domain controller in the Transport Management System (TMS).
5.4 Configuring the Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the EarlyWatch Service or the GoingLive Service. Therefore, you have to set up a remote network connection to SAP. For more information, see SAP Service Marketplace at http://service.sap.com/remotecollection.

5.5 Applying the Latest Kernel and Support Packages

You have to apply the latest kernel and Support Packages for your SAP system from SAP Service Marketplace.

⚠️ Caution

Before you apply support packages, make sure that you read the release notes for your SAP system. You can find these at http://service.sap.com/releasenotes. The release notes might include information about steps you have to perform after you have applied the support packages.

⚠️ Caution

Make sure that the entry DIR_CT_RUN exists in the instance profile. Otherwise you cannot restart the system after patches have been applied.

You can use Java Support Package Manager (JSPM) to apply both the latest ABAP+Java or Java kernel and Java support packages.

JSPM is a Java standalone tool that you can use with SAP NetWeaver 7.1. JSPM uses the Software Deployment Manager (SDM) to apply support packages and patches and to deploy software components.

For more information about JSPM and how to use this tool, see the SAP Library [page 10]: Administrator’s Guide ▶ Technical Operations for SAP NetWeaver ▶ General Administration Tasks ▶ Software Life-Cycle Management ▶ Software Logistics ▶ Application Server Java (AS Java) ▶ Software Logistics ▶ Software Maintenance ▶ Java Support Package Manager (JSPM) ▶

05/16/2008 PUBLIC 67/94
5.6 Post-Installation Steps for the Host Agent

You have to perform the following steps on each host where the host agent is installed. This applies whether the host agent is installed on a host within the SAP system or standalone on another host.

Procedure

1. You check whether the installed services are available as follows:
   a) Log on as user sapadm.
   b) Check whether the following services are available:
      ■ The control program saphostexec
      ■ The operating system collector saposcol
      ■ The SAP NetWeaver Management agent SAPHostControl (sapstartsrv in host mode)
Note
When the host is booted, the startup script `sапinit` automatically starts the required
executables.

2. You configure the host agent according to your requirements.

More Information
For more information, see the SAP Library [page 10]:
- Function-Oriented View ➤ Application Server ABAP ➤ Administration Tools for AS ABAP ➤ Monitoring in the
  CCMS ➤ Infrastructure of the SAP NetWeaver Management Agents ➤

5.7 Checking the SAP Java Documentation

Here you can find information in the SAP Library about the configuration of Application Server
Java (AS Java) and about SAP Java technology.

Procedure

1. Choose the following in the SAP library [page 10]:
- Function-Oriented View ➤ Application Server Java ➤ AS Java (Application Server Java) ➤

2. Check the following documentation for information relevant to running your Java system:

<table>
<thead>
<tr>
<th>Manual</th>
<th>Contents</th>
</tr>
</thead>
</table>
| ➤ Application Server Infrastructure ➤ Architecture of the SAP NetWeaver Application Server ➤ Architecture of AS Java ➤ | This documentation provides an overview of the architecture of the Application Server Java (AS Java). It contains information on:
  - Java cluster architecture
  - Application Server Java (AS Java) system architecture
  - Zero Administration (technical configuration within AS Java) |
| ➤ Application Server Java Administration ➤ | This documentation describes how to administer the SAP system, focusing on AS Java. It contains information on:
  - Administration Tools
    - SAP Management Console
      The SAP Management Console (SAP MC) provides a common framework for centralized system management. It lets you monitor and perform basic administration tasks on the SAP system centrally, thus simplifying system administration.
    - SAP NetWeaver Administrator
      SAP NetWeaver Administrator is a Web-based tool for administration and monitoring that offers a single entry point to configure, administer, and monitor your SAP NetWeaver system, its components, and the applications running on it.
    - Config Tool
      The Config Tool provides offline configuration of the SAP NetWeaver Application Server Java (AS Java) instances. It lets you |
modify the properties of all services, managers, and applications. In addition, it enables you to manage log configurations offline, add filters, and edit the JVM parameters.

- Administration Using Telnet
- SAP Java Virtual Machine (SAP JVM)
- The Startup Framework for AS Java
- Administration Functions for Information Lifecycle Management

Identity Management of the SAP NetWeaver Application Server (AS) Java enables you to manage users and roles for access to applications of the AS Java and the data, which the applications require. The user management engine (UME) provides identity management as a service of the AS Java. This documentation contains information on:

- User Management Engine
- Authorization Concept of the AS Java
- Configuring Identity Management
- Administration of Users and Roles

This documentation contains information on:

- Cluster and Load Balancing (AS-Java)
- Single points of failure for SAP NetWeaver AS Java

This documentation contains information on additional system security functions for AS Java.

5.8 CE-Specific Post-Installation Activities

This section describes the steps that you have to perform after the installation has finished successfully.

Running the Configuration Wizard (Optional)

Note

You can run the configuration wizard only once and only directly after installing and patching your SAP system.

After SAPInst has finished, run the configuration wizard to apply automated configuration tasks to your system.

For SAP NetWeaver CE, you need to run the following configuration tasks, depending on the installed components:

- Configuration of Services Registry Webservice Destinations
- Configuration and Mirroring of local NWDS Update Site
- Initial setup ADS in CE (if ADS is available on your platform)
- Change Management Service (CMS): Create an Application Skeleton
- Change Management Service (CMS): Modify a Software Component
For more information about how to start the configuration wizard, see the configuration documentation in the SAP Solution Manager.

**Enabling Adobe Document Services**
If you have installed SAP NetWeaver Composition Environment with the Adobe Document Services add-on a Windows platform, you must complete the following post-installation steps to enable the add-on. In case you have installed an AS Java cluster, apply the procedure to the central host, as well as to all hosts where additional application server instances are running.

1. Using the SAP Management Console, stop the AS Java system.
2. From the Start menu, open ▶ Control Panel ▶ Administrative Tools ▶ Computer Management ▶ Services and Applications ▶ Services ▶.
3. Select SAP<SID>_<Instance_Number> (for example, SAPCE1_00) and open Properties from the context menu.
4. On the Log On tab page, enable the Local System account indicator.
5. Repeat the above steps for the second SAP<SID>_<Instance_Number> service that you see in the list.
6. Start the AS Java system.

Adobe LiveCycle Designer
For more information about how to install and configure the Adobe LiveCycle Designer see SAP Note 962763.

**Enabling Services Registry**
You must apply additional configuration steps to enable Services Registry after you have installed an SAP NetWeaver Composition Environment system containing the following components:

- Java Application Server and Composition Platform
- Java Application Server and Adobe Document Services

To enable Services Registry, you must apply the following configuration template to your system:

CE_Complete_Stack_production_full

**Note**
For more information about what configuration templates are available, see Configuration Templates [page 77].
See also
Developing and Composing Applications  Consuming Enterprise Services  Searching for Services  Services Registry  
Tasks  Searching & Browsing Service Definitions  Configuring the Services Registry

**Configuring the Portal in SAP NetWeaver CE**

After installing the portal in SAP NetWeaver CE, a number of deactivated or irrelevant tools are displayed in the UI. To display the correct portals tools for CE, proceed as follows:

1. Open a browser and log on to your portal as an administrator.
2. In the same browser session, enter the following URL:
   
   
   ```
   content.layers.ContentLayersTool
   ```
   
   where `<host>` is the host name of your server and `<httpport>` is the port number of your server.
3. In the Portal Mode Configuration Tool, choose *Activate Development Mode* to restore the portal tools and content that are assigned to the development mode.
4. Restart or refresh your browser.
5. In the SAP Management Console, restart the server.

You may then continue with the mandatory and optional configuration steps as described in

Configuration of SAP NetWeaver Composition Environment  Configuration for CE Additional Components  Configuring the Portal

**Changing the Password for the Internet Communication Manager (ICM)**

You can monitor and manage the Internet Communication Manager (ICM) from the command line program.

After the installation of your SAP NetWeaver CE system has successfully finished, you need to change the ICM password manually. To do so, proceed as follows:

1. Log on at operating system level to the computer where the ICM is running.
2. Start the program `icmon` with `icmon -a profile=<instance_profile>` to maintain the authentication file (default: `authfile.txt`).
3. Choose `a` to add a user.
4. Choose `c` to change the password of the existing user.
5. Choose `s` to save your settings.

**Further Configuration Steps**

After installing your SAP NetWeaver CE system and performing the post-installation steps to get the system up & running, you may need to perform further configuration steps. Refer to the following documentation to proceed with your tasks:
If you are a system administrator, refer to \texttt{http://help.sap.com/nwce} \textit{Administrator's Guide}. It contains information about how to configure and administer your system.

If you are a developer, refer to \texttt{http://help.sap.com/nwce} \textit{Developer's Guide}. It provides guidelines for developing applications using the SAP NetWeaver CE.

\begin{note}
The SAP NetWeaver CE documentation is also available offline as a part of your installation. To access it, choose \textit{Start} \textit{All Programs} \textit{SAP NetWeaver} \textit{Composition Environment 1.0} \textit{Documentation}.
\end{note}

### 5.9 Performing a Full Installation Backup

You must perform a full offline backup after the configuration of your SAP system. If required, you can also perform a full offline backup after the installation (recommended). In addition, we recommend you to regularly back up your database.

\begin{caution}
Make sure that you fully back up your database so that you can recover it later if necessary.
\end{caution}

You need to back up the following directories and files:

- All SAP-specific directories:
  - \texttt{/usr/sap/<SAPSID>}
  - \texttt{/usr/sap/trans}
  - \texttt{<sapmnt>/<SAPSID>}
  - Home directory of the user \texttt{<sapid>adm}
- The root file system

This saves the structure of the system and all configuration files, such as file system size, logical volume manager configuration, and database configuration data.

\begin{note}
This list is only valid for a standard installation.
\end{note}

**Prerequisites**

- You have logged on as user \texttt{<sapid>adm} and stopped the additional application server instance.

This procedure works on all hardware platforms. For more information about operating system-specific backup procedures, see your operating system documentation.
## Backing Up the Installation

1. Log on as user root.
2. Manually create a compressed tar archive that contains all installed files:
   - Saving to tape:
     ```bash
tar -cf <file_system> | compress -c > <tape_device>
```
   - Saving to the file system:
     ```bash
tar -cf <file_system> | compress -c > ARCHIVENAME.tar.Z
```

   ![Note](image1.png)
   You can also execute the following command to manually create a compressed GNU tar archive that contains all installed files and save it to the file system:
   ```bash
tar -czf <ARCHIVENAME>.tgz <file_system>
```

## Restoring Your Backup

If required, you can restore the data that you previously backed up.

![Caution](image2.png)
Check for modifications in the existing parameter files before you overwrite them when restoring the backup.

1. Log on as user root.
2. Go to the location in your file system where you want to restore the backup image.
3. Restore the data with the following commands:
   - From tape:
     ```bash
cat <tape_device> | compress -cd | tar -xf -
```
   - From the file system:
     ```bash
cat ARCHIVENAME.tar.Z | compress -cd | tar -xf -
```

   ![Note](image3.png)
   If you want to restore the data from a GNU tar archive, you have to execute the following command:
   ```bash
tar -xzf <ARCHIVENAME>.tgz
```

## 5.10 Post-Installation Steps for the Diagnostics Agent

To implement the E2E Root Cause Analysis scenario, you have to perform the following post-installation steps.
Prerequisites
You have installed an AS Java central instance or dialog instance.

Procedure
1. Upgrade the JDK on AIX and Linux x86_64 operating systems as described in SAP Note 1093831. This avoids connection problems between the Diagnostics Agent and the Diagnostics Managing system, as well as out-of-memory errors and class-loader problems.
2. Plan the implementation of the SAP Solution Manager Diagnostics Agent as described in the Root Cause Analysis Installation and Upgrade Guide, which you can find at one of the following:
   - [http://service.sap.com/instguides](http://service.sap.com/instguides)  SAP Components  SAP Solution Manager  <Current Release>
This page is intentionally left blank.
6 Additional Information

Here you can find additional information about the installation of your SAP system. There is also information about how to delete an SAP system.

- Mounting a CD / DVD for Linux [page 79].
- Additional Information about SAPinst [page ].
- Starting and Stopping the SAP System [page 80].
- Deleting an SAP System [page 86].

6.1 Transporting Self-Developed Software Component Archives (SCA) into the System

Prerequisites
You have developed your own Software Component Archives (SCA) and want to transport them into your SAP NetWeaver CE system.

Procedure
To transport your SCAs to the SAP NetWeaver CE system, proceed as follows:

2. Log on to your system as user root and, from an empty directory, run the update tool `update<ID>.sh`.

   Note
   If the tool displays descriptions such as Applying Support Packages, you can ignore them.

3. In the dialog screens, specify the directory where your SCAs are located.
4. Follow the on-screen instructions.

6.2 Configuration Templates

Configuration templates contain the predefined instance configuration for specific scenarios. They are automatically applied according to the installation option you have selected. The templates
are designed to optimize system performance by applying certain configuration to the Java Virtual Machine and the application server, as well as by applying startup filters to AS Java services and applications to start only those relevant for the selected installation options.

The following table provides information about the available templates with SAP NetWeaver Composition Environment. In the template name, replace the <system_mode> parameter by development (for the templates relevant to systems installed in development mode) or production (for the templates relevant to systems installed in productive mode).

<table>
<thead>
<tr>
<th>Configuration Template</th>
<th>Selected Installation Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE_Java_EE_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation</td>
</tr>
<tr>
<td>CE_Composition_Environment_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation</td>
</tr>
<tr>
<td>CE_Adobe_Document_Service_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Adobe Document Services Add-on Installation</td>
</tr>
<tr>
<td>CE_Composite_Voice_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Voice Add-on Installation</td>
</tr>
<tr>
<td>CE_Complete_Stack_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation + Adobe Document Services Add-on Installation + Voice Add-on Installation</td>
</tr>
</tbody>
</table>

If your selection cannot be mapped to one of the combinations in the above table, the template CE_Complete_Stack_<system_mode>_full is applied. It starts all applications and services needed to run the complete stack.

You can manually apply a different configuration template if you want to switch to another installation option. For example, by changing from template CE_Complete_Stack_<system_mode>_full to CE_Java_EE_<system_mode>_full, you achieve shorter startup times and less memory consumption, but also less functionality since not all applications and services are running.


Note
Make sure that you do not apply a development template to a productive system or vice versa.

### 6.3 Uninstalling SAP NetWeaver Composition Environment

You have to uninstall all components of the SAP NetWeaver Composition Environment separately. You can uninstall your SAP NetWeaver CE system in different ways.
Uninstalling SAP NetWeaver CE

Start the uninstallation from the directory `/usr.sap/SID/SYS/exe/uc/<platform>/uninstall`.

Uninstalling SAP NetWeaver CE Using SAPinst

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPinst from the SAP Installation Master DVD as described in the section Installing SAP NetWeaver Composition Environment.
3. In the Welcome screen, choose Uninstall SAP System or Single Instances from the tree structure.
4. Follow the on-screen instructions.

6.4 Mounting a CD / DVD for Linux

You can use this procedure to mount a CD or DVD.

**Note**
The placeholder `<medium-mountdir>` is used for either `<cd-mountdir>` or `<dvd-mountdir>`.

**Procedure**

1. Log on as user root.
2. To create a mount point for the CD / DVD, enter the following command:
   ```bash
   mkdir <medium-mountdir>
   ```
   **Example**
   `<medium-mountdir>` is `/sapcd`

3. To mount the first CD / DVD device, enter the following command:
   ```bash
   mount -t iso9660 -r <device> <medium-mountdir>
   ```
   where `<device>` is `/dev/cdrom` for non-SCSI CD devices and `/dev/scd<n>` for SCSI drives with the device number `<n>`.
   If the file names on the mounted CD / DVD are written in lowercase letters, remount the CD / DVD with the following commands:
   ```bash
   umount <device>
   mount -t iso9660 -r -o map=off <device> <medium-mountdir>
   ```
6.5 Heterogeneous SAP System Installation

This section provides information on the installation of an SAP system in a heterogeneous system landscape. “Heterogeneous system landscape” means that application servers run on different operating systems.

Procedure

See SAP Note 1067221 for information on

- supported combinations of operating systems and database systems,
- how to install an application server on Windows in a heterogeneous (UNIX) SAP system environment,
- heterogeneous SAP system landscapes with different UNIX operating systems.

6.6 Starting and Stopping SAP System Instances

You can start and stop SAP system instances and the Diagnostics Agent by using the SAP Management Console (SAP MC) [page 80].

Apart from using the SAP Management Console (SAP MC) you can also use scripts to

- Start or stop SAP system instances [page 84]
- Start or stop the Diagnostics Agent [page 85].

6.6.1 Starting and Stopping the SAP System Using the SAP Management Console

Note

If your newly installed SAP system is part of a heterogeneous SAP system landscape comprising systems or instances on Windows platforms, you can also start and stop it from a Windows system or instance using the Microsoft Management Console (MMC).

For more information about handling the MMC, see the SAP Library [page 10]:

Function-Oriented View ➤ Application Server ABAP ➤ Administration Tools for AS ABAP ➤ Monitoring in the CCMS ➤ SAP Microsoft Management Console: Windows

Prerequisites

- Make sure that the host on which you start SAP MC meets the following requirements:
  - Java Runtime Environment (JRE) 5.0 is installed.
  - The browser supports Java.
  - The browser’s Java plug-in is installed and activated.
- You have logged on to the host as user <sapsid>adm.
Starting the Web-Based SAP Management Console

1. Start a Web browser and enter the following URL:

   http://<hostname>:5<instance_number>13

   Example

   If the instance number is 53 and the host name is saphost06, you enter the following URL:

   http://saphost06:5313

   This starts the SAP MC Java applet.

   Note

   If your browser displays a security warning message, choose the option that indicates that you trust the applet.

2. Choose Start.

   The SAP Management Console appears.

   Note

   When you start the SAP MC for the first time for a newly installed SAP system, you have to register your system as described in Registering Systems and Instances below. Having done this, the instances installed on the host you have connected to are already added in the SAP Management Console when you start the SAP MC next time.

   By default, the instances installed on the host you have connected to are already added in the SAP Management Console.

   If you want to change the configuration to display systems and instances on other hosts, see Registering Systems and Instances below.

Starting and Stopping Systems and Instances

Starting an SAP System or Instance

1. In the navigation pane, open the tree structure and navigate to the system node that you want to start.
2. Select the system or instance and then, from the context menu, choose Start.
3. In the Start SAP System(s) dialog box, choose the required options.
4. Choose OK. The SAP MC starts the specified system or system instances.

   Note

   The system might prompt you for the SAP system administrator credentials. To complete the operation, you must have administration permissions. Log in as user <sapsid>adm.
Starting Instances Separately

If you need to start the instances of an SAP system separately, for example when you want to start a distributed or a high-availability system, proceed in the following sequence:

1. Start the database instance.
2. Start the central services instance SCS<Instance_Number>.
3. Start application server instance(s) J<Instance_Number>.

Stopping an SAP System or Instance

1. Select the system or instance you want to stop and choose Stop from the context menu.
2. In the Stop SAP System(s) dialog box, choose the required options.
3. Choose OK. The SAP MC stops the specified system or system instances.

Note

The system might prompt you for the SAP system administrator credentials. To complete the operation, you must have administration permissions. Log in as user <sapsid>adm.

Similarly, you can start, stop or restart all SAP systems and individual instances registered in the SAP MC.

Stopping Instances Separately

If you need to stop the instances of an SAP system separately, for example when you want to start a distributed or a high-availability system, proceed in the following sequence:

1. Stop application server instance(s) J<Instance_Number>.
2. Stop the central services instance SCS<Instance_Number>.
3. Stop the database instance.

Registering Systems and Instances in the SAP Management Console

You can extend the list of systems and instances displayed in the SAP MC, so that you can monitor and administer all systems and instances from a single console. You can configure the SAP MC startup view to display the set of systems and instances you want to manage.

Prerequisites

The SAP MC is started.

Registering SAP Systems

1. In the SAP MC, choose File > New .
2. In the New System dialog box, enter the required data.
If you have already registered systems in the SAP MC, they are stored in the history. To open the System’s History dialog box, choose the browsing button next to the Instance Nr. field. Select an instance of the system that you want to add and choose OK.

3. Choose Finish.

Registering Individual Instances

1. In the SAP MC, choose File ➤ New.
2. In the New System dialog box, enter the required data and deselect Always show all SAP Instances.
3. The SAP MC displays the SAP system node, the instance node and the relevant database node in a tree view in the navigation pane.

To view all instances of the respective SAP system, select the relevant system node and choose Add Application Server from the context menu.

Configuring the SAP MC View

- You can choose the instances that the SAP MC displays automatically on startup:
  1. In the Settings dialog box, select History.
  2. In the right-hand side pane, choose the instance you want the SAP MC to display on startup.
  3. Choose the << button.
  4. Choose Apply and then choose OK.

Similarly, you can remove instances from the startup configuration.

- You can save the current configuration in a file:
  1. Choose File ➤ Save Landscape.
  2. In the Save dialog box, enter the required data.
  3. Choose Save.

- You can load a configuration from a file:
  1. Choose File ➤ Load Landscape.
  2. In the Open dialog box, select the configuration you want to load.
  3. Choose Open.

More Information

For more information about how to handle the SAP MC, see the SAP Library [page 10]:
6.6.2 Starting and Stopping the SAP Instance Using Commands

You need to check that you can start and stop the SAP system after the installation using the scripts `startsap` and `stopsap` in the `exe` directory.

**Prerequisites**

- You have checked the default profile `/<sapmnt>/<SAPSID>/profile/DEFAULT.PFL` for parameter `login/system_client` and set the value to the correct productive system client. For example, the entry must be `login/system_client = 001` if your productive client is 001.
- You have checked the settings for VM parameters as described in SAP Note 723909.
- You have signed on to the SAP system host as user `<sapsid>adm`.
- If you want to use `startsap` or `stopsap` (for example, in a script) and require the fully qualified name of these SAP scripts, create a link to `startsap` or `stopsap` in the home directory of the corresponding user.

**Caution**

If there are **multiple** SAP instances on one host you must add an extra parameter to the scripts using:

- `startsap <instanceID>`

  **Example**

  `startsap D00`

- `stopsap <instanceID>`

**Note**

The instance name (instance ID) of the primary additional application server instance is `JC<Instance_Number>`, the instance name of a Java additional application server instance is `J<Instance_Number>`.

**Starting the SAP Instance**

1. Make sure the primary additional application server instance is up and running on the System i host.
2. To start an additional application server instance, enter the following:

   `startsap <instanceID>`

**Note**

Make sure that the SAP system (and Application Server Java) is up and running before you start or restart additional application server instances (and Application Server Java).
Stopping the SAP Instance
To stop an additional application server instance, enter the following:

`stopsap <instanceID>`

### 6.6.3 Starting and Stopping the Diagnostics Agent Using Scripts

You can start and stop the Diagnostics Agent by running the `smdstart` and `smdstop` scripts. The local versions of these scripts are located in `/usr/sap/<SMDSID>/J<instance_number>/script`. The global versions of these scripts are located in `/usr/sap/<SMDSID>/exe`.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can only start or stop the Diagnostics Agent separately. It is not started or stopped automatically with the SAP system.</td>
</tr>
</tbody>
</table>

You can also use the SAP Management Console (SAP MC) [page 80] to start or stop the Diagnostics Agent.

**Prerequisites**

You have logged on to the central instance or dialog host as user `<smdsid>adm`.

**Procedure**

Starting a Diagnostics Agent Locally

1. Change to the following directory:
   
   `/usr/sap/<SMDSID>/J<Instance_Number>/script`

2. To start the Diagnostics Agent locally, enter this command:
   
   `./smdstart.sh`

Starting Diagnostics Agent(s) Globally

To start Diagnostics Agent(s) globally, enter this command:

`smdstart <SMDSID> <Instance_Number>`

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>smdstart SMD 98</code></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You do not have to specify the <code>&lt;SMDSID&gt;</code> if there is only one Diagnostics Agent system on this host.</td>
</tr>
</tbody>
</table>
### 6.7 Deleting an SAP System

This section describes how to delete a single instance, a standalone engine or a complete SAP system with the *Uninstall* option of SAPinst.

**Caution**

- If you delete network-wide users or groups in an environment with Network Information System (NIS), other SAP installations might also be affected. Before you delete users or groups, make sure that they are no longer required.

**Prerequisites**

- This description assumes that you have installed your SAP system with standard SAP tools according to the installation documentation.
- You are logged on as user *root*.
- If the `saposco1` process on the host where you are working has been started from the SAP system that you want to delete, stop the process using the command `saposco1 -k`.
  
  If there are other SAP systems on the host, log on as user `<sapsid>adm` of the other SAP system and start `saposco1` from there using the command `saposco1 -1`.

**Procedure**

1. Start SAPinst [page 53] and on the *Welcome* screen, choose:
2. Follow the instructions in the SAPinst input dialogs.
Note

For more information about the input parameters, place the cursor on the relevant field and press F1 in SAPinst.

SAPinst first asks you which SAP instances you want to delete. Make sure that you delete the SAP instances in the order as described hereinafter.

3. If required, you can delete the directory /usr/sap/trans and its content manually. SAPinst does not delete /usr/sap/trans because it might be shared.
4. If you created the directories /usr/sap/<SAPSID> and /<sapmnt>/<SAPSID> as mount points, but not as directories on the local file system, you have to remove them manually.
## Typographic Conventions

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt; &gt;</code></td>
<td>Angle brackets indicate that you replace these words or characters with appropriate entries to make entries in the system, for example, “Enter your <code>&lt;User Name&gt;</code>”.</td>
</tr>
<tr>
<td>⬤ ⬤ ⬤</td>
<td>Arrows separating the parts of a navigation path, for example, menu options</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Emphasized words or expressions</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Words or characters that you enter in the system exactly as they appear in the documentation</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Textual cross-references to an internet address, for example, <a href="http://www.sap.com">http://www.sap.com</a></td>
</tr>
<tr>
<td><code>/example</code></td>
<td>Quicklinks added to the internet address of a homepage to enable quick access to specific content on the Web</td>
</tr>
<tr>
<td>123456</td>
<td>Hyperlink to an SAP Note, for example, SAP Note 123456</td>
</tr>
</tbody>
</table>
| **Example** | - Words or characters quoted from the screen. These include field labels, screen titles, pushbutton labels, menu names, and menu options. 
- Cross-references to other documentation or published works |
| **Example** | - Output on the screen following a user action, for example, messages 
- Source code or syntax quoted directly from a program 
- File and directory names and their paths, names of variables and parameters, and names of installation, upgrade, and database tools |
| **EXAMPLE** | Technical names of system objects. These include report names, program names, transaction codes, database table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE |
| ![EXAMPLE] | Keys on the keyboard |


Disclaimer
Some components of this product are based on Java™. Any code change in these components may cause unpredictable and severe malfunctions and is therefore expressly prohibited, as is any decompilation of these components. Any Java™ Source Code delivered with this product is only to be used by SAP’s Support Services and may not be modified or altered in any way.

Legal Software Terms

Terms for Included Open Source Software
This SAP software contains also the third party open source software products listed below. Note that for these third party products the following special terms and conditions shall apply.

1. This software was developed using ANTLR.
2. SAP License Agreement for STLport
   SAP License Agreement for STLPort between
   SAP Aktiengesellschaft
   Systems, Applications, Products in Data Processing
   Dietmar-Hopp-Allee 16
   69190 Walldorf, Germany
   (hereinafter: SAP)
   and
   you
   (hereinafter: Customer)
   a) Subject Matter of the Agreement
      A) SAP grants Customer a non-exclusive, non-transferable, royalty-free license to use the STLport.org C++ library (STLport) and its documentation without fee.
      B) By downloading, using, or copying STLport or any portion thereof Customer agrees to abide by the intellectual property laws, and to all of the terms and conditions of this Agreement.
      C) The Customer may distribute binaries compiled with STLport (whether original or modified) without any royalties or restrictions.
      D) Customer shall maintain the following copyright and permissions notices on STLport sources and its documentation unchanged: Copyright 2001 SAP AG
      E) The Customer may distribute original or modified STLPort sources, provided that:
         ■ The conditions indicated in the above permissions notice are met;
         ■ The following copyright notices are retained when present, and conditions provided in accompanying permission notices are met:
          Copyright 1994 Hewlett-Packard Company
          Copyright 1996,97 Silicon Graphics Computer Systems Inc.
          Copyright 1997 Moscow Center for SPARC Technology.
          Copyright 1999,2000 Boris Fomitchev
          Copyright 2001 SAP AG
         Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Hewlett-Packard Company makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.
         Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that
copyright notice and this permission notice appear in supporting documentation. Silicon Graphics makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Moscow Center for SPARC makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Boris Fomitchev makes no representations about the suitability of this software for any purpose. This material is provided “as is”, with absolutely no warranty expressed or implied. Any use is at your own risk. Permission to use or copy this software for any purpose is hereby granted without fee, provided the above notices are retained on all copies. Permission to modify the code and to distribute modified code is granted, provided the above notices are retained, and a notice that the code was modified is included with the above copyright notice.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. SAP makes no representations about the suitability of this software for any purpose. It is provided with a limited warranty and liability as set forth in the License Agreement distributed with this copy. SAP offers this liability and warranty obligations only towards its customers and only referring to its modifications.

b) Support and Maintenance
SAP does not provide software maintenance for the STLport. Software maintenance of the STLport therefore shall be not included.
All other services shall be charged according to the rates for services quoted in the SAP List of Prices and Conditions and shall be subject to a separate contract.

c) Exclusion of warranty
As the STLport is transferred to the Customer on a loan basis and free of charge, SAP cannot guarantee that the STLport is error-free, without material defects or suitable for a specific application under third-party rights. Technical data, sales brochures, advertising text and quality descriptions produced by SAP do not indicate any assurance of particular attributes.

d) Limited Liability
A) Irrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized operation, if this (i) can be compensated under the Product Liability Act or (ii) if caused due to gross negligence or intent by SAP or (iii) if based on the failure of a guaranteed attribute.

B) If SAP is liable for gross negligence or intent caused by employees who are neither agents or managerial employees of SAP, the total liability for such damage and a maximum limit on the scope of any such damage shall depend on the extent to which its occurrence ought to have anticipated by SAP when concluding the contract, due to the circumstances known to it at that point in time representing a typical transfer of the software.

C) In the case of Art. 4.2 above, SAP shall not be liable for indirect damage, consequential damage caused by a defect or lost profit.

D) SAP and the Customer agree that the typical foreseeable extent of damage shall under no circumstances exceed EUR 5,000.

E) The Customer shall take adequate measures for the protection of data and programs, in particular by making backup copies at the minimum intervals recommended by SAP. SAP shall not be liable for the loss of data and its recovery, notwithstanding the other limitations of the present Art. 4 if this loss could have been avoided by observing this obligation.

F) The exclusion or the limitation of claims in accordance with the present Art. 4 includes claims against employees or agents of SAP.

3. Adobe Document Services
Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. For information on Third Party software delivered with Adobe document services and Adobe LiveCycle Designer, see SAP Note 854621.

**Documentation in the SAP Service Marketplace**

You can find this document at the following address: [https://service.sap.com/instguides](https://service.sap.com/instguides)
This page is intentionally left blank.